Support
Thank you for selecting NETGEAR products.
After installing your device, locate the serial number on the label of your product and use it to register your product at https://my.netgear.com. You must register your product before you can use NETGEAR telephone support. NETGEAR recommends registering your product through the NETGEAR website. For product updates and web support, visit http://support.netgear.com.
Phone (US & Canada only): 1-888-NETGEAR.
Phone (Other Countries): Check the list of phone numbers at http://support.netgear.com/general/contact/default.aspx.

Compliance
For regulatory compliance information, visit http://www.netgear.com/about/regulatory.
See the regulatory compliance document before connecting the power supply.

Trademarks
© NETGEAR, Inc. NETGEAR and the NETGEAR Logo are trademarks of NETGEAR, Inc. Any non-NETGEAR trademarks are used for reference purposes only.
# Table of Contents

## Chapter 1  Overview
- Unpack Your Extender .......................................................... 7
- Top Panel LEDs and Front Panel USB Port .............................. 7
- Rear Panel Ports, Buttons, Antennas, and Connector ............... 9
- Attach the Stand ............................................................... 10
- Attach the Rubber Feet ....................................................... 11
- Retrieve and Display the Product Label ................................. 12
- When to Use Your Extender .................................................. 13
- How the Extender Works ...................................................... 13
- Support for the 801.11ac Networking Standard ....................... 14

## Chapter 2  Get Started
- How to Position the Extender ............................................... 16
- Connect the Extender to Your WiFi Router ............................. 16
- Connect the Extender with WPS to a WiFi Network ................. 17
- Access the Extender over WiFi and Use Smart Setup ............... 19
- Access the Extender over Ethernet and Use Smart Setup ........... 27

## Chapter 3  Manage the Extender Network and Security Settings
- Log In to the Extender After Initial Setup .............................. 36
- Change the Password .......................................................... 38
- Set Up Password Recovery ................................................... 38
- Connect the Extender to a WiFi Network Without Using Smart Setup ......................................................... 39
- Connect the Extender to a Hidden WiFi Network ................. 43
- Use WPS to Add a Computer to the Extender’s WiFi Network .......... 46
  - Use WPS with the Push Button Method ............................. 47
  - Use WPS with the PIN Method ........................................ 48
- Manage the Extender WiFi Settings ...................................... 49
  - Configure WPA, WPA2, or WPA + WPA2 .......................... 54
  - Configure WEP .............................................................. 55
- Change the Extender IP Address and Device Name ...................... 57
- Manage Advanced WiFi and WPS Settings .......................... 58
- Manage a WiFi Access List .................................................... 60
  - Set Up and Enable the Access List ................................. 61
  - Disable the Access List .................................................. 63
  - Change a Device on the Access List ............................... 64
  - Remove a Device from the Access List ............................ 66
- Set the Operating Mode to FastLane Technology ....................... 67
- Run Smart Setup Again After Initial Setup ............................. 69
Connect Ethernet-Enabled Devices ................................................. 73

Chapter 4  Maintain and Monitor the Extender

Recover the admin Password ......................................................... 76
Back Up and Manage the Extender Configuration ............................... 76
    Back Up the Configuration Settings ........................................... 77
    Restore the Configuration Settings ........................................... 77
Return the Extender to Its Factory Default Settings ............................ 78
    Use the Restore Factory Settings Button ................................... 79
    Erase the Extender Configuration Settings .................................. 79
Update the Firmware ...................................................................... 80
View the Status and Traffic Statistics of the Extender ......................... 81
View the Wired and WiFi Network Devices ....................................... 85

Chapter 5  Share a USB Drive That Is Attached to the Extender

USB Drive Requirements ............................................................... 88
Access a USB Drive on the Network ................................................ 88
Back Up Windows Computers with ReadySHARE Vault ........................ 89
Back Up Mac Computers with Time Machine ..................................... 90
    Set Up a USB Hard Drive on a Mac .............................................. 90
    Prepare to Back Up a Large Amount of Data ................................. 91
    Use Time Machine to Back Up onto a USB Hard Drive ..................... 91
Control Access to the USB Drive ..................................................... 92
Use FTP Within the Network .......................................................... 94
View Network Folders on a USB Drive ............................................. 95
Add a Network Folder on a USB Drive ............................................ 96
Change a Network Folder on a USB Drive ....................................... 98
Approve USB Devices ..................................................................... 100
Safely Remove a USB Drive ........................................................... 101

Chapter 6  Use the Extender as a Media Server

Specify ReadyDLNA Media Server Settings ...................................... 103
Play Media from a USB Drive on TiVo .............................................. 104

Chapter 7  Share a USB Printer Through the Extender

Install the Printer Driver and Cable the Printer .................................. 108
Download the ReadySHARE Printer Utility ...................................... 108
Install the ReadySHARE Printer Utility .......................................... 108
Use the Shared Printer .................................................................... 110
View or Change the Status of a Printer ............................................. 111
Use the Scan Feature of a Multifunction USB Printer ......................... 112
Change NETGEAR USB Control Center Settings ............................. 113
Chapter 8  FAQs and Troubleshooting

FAQs .................................................................115
You Cannot Connect to the Extender ................................118
You Cannot Join a WiFi Network and Receive an Error Message ...... 120
Improve the Connection Between the Extender and the WiFi Router ...... 121

Appendix A  Factory Settings and Technical Specifications

Factory Default Settings .................................................123
Technical and Environmental Specifications .......................... 124
Overview

This user manual is for the NETGEAR® AC1200 WiFi Range Extender, model EX6200, which is referred to as the extender.

This chapter covers the following topics:

- Unpack Your Extender
- Top Panel LEDs and Front Panel USB Port
- Rear Panel Ports, Buttons, Antennas, and Connector
- Attach the Stand
- Attach the Rubber Feet
- Retrieve and Display the Product Label
- When to Use Your Extender
- How the Extender Works
- Support for the 801.11ac Networking Standard

---

**Note:** For more information about the topics covered in this manual, visit the support website at support.netgear.com.

---

**Note:** Firmware updates with new features and bug fixes are made available from time to time on downloadcenter.netgear.com. Some products can regularly check the site and download new firmware, or you can check for and download new firmware manually. If the features or behavior of your product does not match what is described in this guide, you might need to update your firmware.

---

**Note:** In this manual, the terms wireless and WiFi are interchangeable.
Unpack Your Extender

Your box contains the following items:

• AC1200 WiFi Range Extender
• Power adapter
• Snap-on stand
• Four rubber feet
• Installation guide
• Do More booklet

Top Panel LEDs and Front Panel USB Port

Use the LEDs during installation to find the best location for the extender or to monitor the extender performance. The following figure shows the extender in upright position, with the stand attached. (For information about attaching the stand, see *Attach the Stand* on page 10.)

![Top panel LEDs and front panel USB port](image)

The following table describes the LEDs.
### Table 1. Front panel LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2.4 GHz Link Rate LED</strong></td>
<td><strong>Green.</strong> The 2.4 GHz WiFi connection between the extender and the WiFi router is optimum.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you press the <strong>WPS</strong> button on the rear panel of the extender, the LED blinks green for two minutes.</td>
</tr>
<tr>
<td></td>
<td><strong>Amber.</strong> The 2.4 GHz WiFi connection between the extender and the WiFi router is good.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This LED also lights amber during the startup process of the extender. After about one minute, the LED lights green or turns off, depending on the WiFi connection between the extender and the WiFi network.</td>
</tr>
<tr>
<td></td>
<td><strong>Red.</strong> The 2.4 GHz WiFi connection between the extender and the WiFi router is poor.</td>
</tr>
<tr>
<td></td>
<td><strong>Off.</strong> The extender and the WiFi router do not have a 2.4 GHz WiFi connection.</td>
</tr>
<tr>
<td><strong>5 GHz Link Rate LED</strong></td>
<td><strong>Green.</strong> The 5 GHz WiFi connection between the extender and the WiFi router is optimum.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you press the <strong>WPS</strong> button on the rear panel of the extender, the LED blinks green for two minutes.</td>
</tr>
<tr>
<td></td>
<td><strong>Amber.</strong> The 5 GHz WiFi connection between the extender and the WiFi router is good.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This LED also lights amber during the startup process of the extender. After about one minute, the LED lights green or turns off, depending on the WiFi connection between the extender and the WiFi network.</td>
</tr>
<tr>
<td></td>
<td><strong>Red.</strong> The 5 GHz WiFi connection between the extender and the WiFi router is poor.</td>
</tr>
<tr>
<td></td>
<td><strong>Off.</strong> The extender and the WiFi router do not have a 5 GHz WiFi connection.</td>
</tr>
<tr>
<td><strong>LAN LEDs (1 through 5)</strong></td>
<td><strong>Green.</strong> An Ethernet device is connected to the LAN port.</td>
</tr>
<tr>
<td></td>
<td><strong>Off.</strong> No Ethernet device is connected to the LAN port.</td>
</tr>
<tr>
<td><strong>Device to Extender LED</strong></td>
<td><strong>Green.</strong> The extender is connected to a computer or WiFi device.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you press the <strong>WPS</strong> button on the rear panel of the extender, the LED blinks green for two minutes.</td>
</tr>
<tr>
<td></td>
<td><strong>Amber.</strong> The extender is starting or is applying WiFi settings. After about one minute, the LED turns green. During the startup process, both Link Rate LEDs also light amber. After about one minute, these LED light green or turn off, depending on the WiFi connection between the extender and the WiFi network.</td>
</tr>
<tr>
<td></td>
<td><strong>Off.</strong> The extender is not connected to a computer or WiFi device.</td>
</tr>
</tbody>
</table>
Table 1. Front panel LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB LED</td>
<td>Solid green. A USB device is connected to the USB port.</td>
</tr>
<tr>
<td></td>
<td>Off. No USB device is connected to the USB port.</td>
</tr>
</tbody>
</table>

Rear Panel Ports, Buttons, Antennas, and Connector

The following figure shows the ports, buttons, antennas, and connector on the rear panel of the extender.

![Rear panel diagram]

Two preinstalled 5dBi antennas

WPS button

Ethernet LAN ports

Restore Factory Settings button

On/Off button

Power connector

Figure 2. Rear panel

The antennas are preinstalled. In the unlikely situation that an antenna has loosened, you must tighten it. (A loose antenna could affect the performance of the extender.)
To tighten an antenna:

1. Straighten the antenna.
2. Turn the antenna clockwise until tightened.

After you have tightened the antenna, you can change its position.

Attach the Stand

If you prefer to place the extender in upright (vertical) position, attach the stand that comes with the extender.

Although the extender functions well in either horizontal or vertical position, a horizontal position might give a better performance.
To attach the stand:

1. Place the stand on a flat surface.
2. Hold the extender in upright position with the left side of the extender pointing down. (The left side has three rectangular openings.)
   The top panel of the extender and the three vertical support posts of the stand must face the same direction.
3. Lower the extender onto the stand until the support posts of the stand snap into the rectangular openings of the extender.

Attach the Rubber Feet

If you prefer to place the extender in horizontal position, you can attach the rubber feet that come with the extender.

To attach the rubber feet:

1. Place the extender upside down, with the red panel facing you. (The red panel is the bottom.)
2. In each corner, attach a rubber foot in such a way that it covers the triangle.
Retrieve and Display the Product Label

The product label that you can retrieve from the bottom panel of the extender contains the preset login information, serial number, security pin, MAC addresses of the radios, and other information.

➢ To retrieve the product label from the extender:

1. Place the extender upside down, with the red panel facing you. (The red panel is the bottom.)
2. Locate the label handle that has NETGEAR printed on it, and pull out the product label.

![Product Label Diagram](image)

**Figure 5. Pulling out the product label**

![Product Label Image](image)

- Preset login information
- Serial number
- Security pin
- MAC address of the 2.4 GHz radio
- MAC address of the 5 GHz radio

**Figure 6. Product label**
When to Use Your Extender

NETGEAR recommends that you connect to the extender only when your existing home network connection is poor. Data traffic routed through the extender is inherently slower than traffic routed directly from the network.

NETGEAR recommends that you connect through the extender network only when the WiFi device is in a “dead zone” where connection from the existing network is poor or nonexistent.

How the Extender Works

The extender works like a bridge between a WiFi router (or a WiFi access point) and a WiFi device outside the range of the WiFi router. The extender has two main jobs:

- The extender connects to a WiFi network that is up and running.
  
  When the extender connects over WiFi to an existing network, it functions as a network client, similar to how a WiFi device connects to a network.

- The extender acts as an access point for WiFi devices.
  
  The extender has its own WiFi network that WiFi devices can join. In its role as an access point, the extender performs tasks that WiFi routers do, such as broadcasting its network name (SSID).

The extender must do each of these jobs so that both ends of the bridge are in place.

![Figure 7. Range extender in a home](image)
Support for the 801.11ac Networking Standard

The extender supports the 802.11ac networking standard. This new standard offers better speed, improved reliability, and more range than older WiFi networking standards.

The extender is backward compatible with earlier WiFi standards. However, to get the benefits of 802.11ac, your WiFi router must support the 802.11ac WiFi networking standard.

To learn more about the 802.11ac WiFi networking standard, visit [http://www.netgear.com/landing/80211ac/](http://www.netgear.com/landing/80211ac/).

![3x Speed]

Figure 8. Speed comparison between the 802.11n and 802.11ac standards
Get Started

This chapter covers the following topics:

• How to Position the Extender
• Connect the Extender to Your WiFi Router
• Connect the Extender with WPS to a WiFi Network
• Access the Extender over WiFi and Use Smart Setup
• Access the Extender over Ethernet and Use Smart Setup
How to Position the Extender

The ideal location to place the extender is halfway between your WiFi router and your WiFi device.

![Figure 9. Range extender location](image)

The best connection is established with a clear line of sight between the extender and the WiFi router and a clear line of sight between the extender and the WiFi device that you are using. If a thick wall or other materials block this straight path, move the extender to a different location halfway between the WiFi device and the WiFi router.

Depending on the location that you decide on, either place the extender horizontally or attach the stand and place the extender vertically. Although the extender functions well in either horizontal or vertical position, a horizontal position might give a better performance.

When you make the initial connection between the extender and the WiFi router, place the extender close to the WiFi router. After you have established a connection between the extender and the WiFi router, move the extender to the location where you intend to use it. (You might need to unplug the extender, plug it in again at its new location, and restart it.) Use the Link Rate LEDs on the extender to choose the location where the connection between the extender and the WiFi router is optimal. These steps are described in detail in the sections that describe how to connect the extender to a WiFi network.

Connect the Extender to Your WiFi Router

To connect the extender to your WiFi router and find the best location for the extender, use one of the following methods:

- **WPS.** Use the extender’s WPS button to establish a WiFi connection between the extender and the WiFi router (see Connect the Extender with WPS to a WiFi Network). Use this method if your WiFi router supports Wi-Fi Protected Setup (WPS).
- **WiFi.** Use a computer or WiFi device to join the extender’s default WiFi network, then launch a web browser to set up the connection between the extender and a WiFi network (see Access the Extender over WiFi and Use Smart Setup). Use this method if your WiFi router does not support WPS.
- **Ethernet.** Use an Ethernet cable to connect a computer to the extender, then launch a web browser to set up the connection between the extender and a WiFi network (see Access the Extender over Ethernet and Use Smart Setup). Use this method if you have difficulty establishing a WiFi connection to the extender.
Connect the Extender with WPS to a WiFi Network

The easiest way to connect the extender to a WiFi network is by using Wi-Fi Protected Setup (WPS). For this method to be successful, your WiFi router must support WPS. If your WiFi router does not support WPS, see one of the following sections:

- **Access the Extender over WiFi and Use Smart Setup** on page 19
- **Access the Extender over Ethernet and Use Smart Setup** on page 27

WPS lets you join a secure WiFi network without typing the network name and password. The WPS button is a physical button on the rear panel of the extender. Your WiFi router might have a physical WPS button, a software WPS button, or both.

WPS does not support WEP network security. If you are using WEP security, follow the instructions in **Access the Extender over WiFi and Use Smart Setup** on page 19.

➢ To connect the extender with WPS to a WiFi router and find the best location for the extender:

1. Place the extender close to the WiFi router.
   
   **Note:** In a later step in this procedure, after you have established a connection to the WiFi router, you can place the extender at its permanent location.

2. Plug the extender into an electrical outlet.

3. If necessary, press the **Power** button.

   The Device to Extender LED and the two Link Rate LEDs light amber during the startup process. After about one minute, these LEDs turn off.

   You are now ready to connect the extender to your WiFi router.

4. Press the **WPS** button on the rear panel of the extender.

   Both Link Rate LEDs [2.4 GHz] and the Device to Extender LED [up arrow] blink green for two minutes.

5. Within two minutes, press the **WPS** button on your WiFi router.

   After a few seconds, the extender connects to your existing WiFi network. Because you placed the extender close to the WiFi router, the 2.4 GHz Link Rate LED on the extender lights green, indicating a good connection between the WiFi router and the extender.

   If the 2.4 GHz Link Rate LED does not light green, try **Step 4** and **Step 5** again. If it still does not light green, see **Access the Extender over WiFi and Use Smart Setup**.

6. If your WiFi router supports the 5 GHz band (not all routers do), and you want to extend that band, repeat **Step 4** and **Step 5** and check that the 5 GHz Link Rate LED lights green to confirm the connection.

7. Now that the extender is connected to the WiFi router, move it to a location where you can boost your WiFi range.

   The location you choose must be within the range of your existing WiFi router network.
8. Plug the extender into an electrical outlet at the new location and restart the extender. Unless the extender is outside the range of your WiFi router, the extender connects automatically to the WiFi router.

The Link Rate LEDs help you choose a spot where the extender-to-router connection is optimal. The following tables describe how the LEDs show the quality of the connection.

### 2.4 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

### 5 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

If the Link Rate LED is off, the extender cannot connect to the WiFi router. If the Link Rate LED is red, the extender has a poor connection to the WiFi router.

9. If the extender has no connection or a poor connection, move the extender closer to your WiFi router and try again until the 2.4 GHz or 5 GHz Link Rate LED is green, or at least amber.

10. Use a WiFi network manager on the computer or mobile device to connect to the extender’s newly created WiFi network.

By default, the extender adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name, for example:

- **Existing network name.** *MyNetworkName*
- **New extended 2.4 GHz network name.** *MyNetworkName_2GEXT*
- **New extended 5 GHz network name.** *MyNetworkName_5GEXT*

11. Select the new network and use your WiFi router password to connect.

You are now using your extended WiFi network.
Access the Extender over WiFi and Use Smart Setup

If your WiFi router does not support WPS, access the extender over WiFi and use the browser-based NETGEAR genie® Smart Setup to connect the extender to an existing WiFi network.

The extender has a default NETGEAR_EXT WiFi network name (SSID) in the 2.4 GHz band so you can access it over WiFi. After you have used Smart Setup to connect the extender to an existing WiFi network, the extender changes its default NETGEAR_EXT network name to the name of the existing WiFi network and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name, for example:

- **Existing network name.** MyNetworkName
- **New extended 2.4 GHz network name.** MyNetworkName_2GEXT
- **New extended 5 GHz network name.** MyNetworkName_5GEXT

➢ **To access the extender over WiFi and use Smart Setup to connect the extender to an existing WiFi network:**

1. Place the extender close to the WiFi router.

   **Note:** In a later step in this procedure, after you have established a connection to the WiFi router, you can place the extender at its permanent location.

2. Plug the extender into an electrical outlet.
3. If necessary, press the **Power** button.

   The Device to Extender LED and the two Link Rate LEDs light amber during the startup process. After about one minute, these LEDs turn off.

4. Make sure that your computer or mobile device is not connected to an Ethernet network.

   If the computer or mobile device is already connected to an Ethernet network, you might not be able to connect to the extender.

5. Open a WiFi network manager on your computer or mobile device to find and connect to the default NETGEAR_EXT WiFi network of the extender.
You can use any WiFi network utility on a computer, tablet, or smartphone to find and connect to the NETGEAR_EXT WiFi network of the extender. The following figure shows an example of a WiFi network utility.

After the connection with the computer or mobile device is established, the Device to Extender LED lights solid green.

6. Open a web browser window from the same computer or mobile device.

The browser takes you directly to the NETGEAR genie Smart Setup start screen.

**Note:** If you are not automatically directed to the NETGEAR genie Smart Setup start screen, go to [www.mywifiext.net](http://www.mywifiext.net), and enter **admin** for the user name and **password** for the password.

Smart Setup searches for existing WiFi networks automatically and displays the networks in the 2.4 GHz band.
7. Select a 2.4 GHz WiFi network to extend, and click the **Continue** button.

8. Enter the security settings for the existing 2.4 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   - If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (**64 bit** or **128 bit**).
     b. Select the radio button that corresponds to the key that you want to use (**Key 1**, **Key 2**, **Key 3**, or **Key 4**).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the **Continue** button.
If Smart Setup detects any networks in the 5 GHz band, it displays them.

**9.** Select a 5 GHz WiFi network to extend, and click the **Continue** button.

**Note:** If your router does not support the 5 GHz band (not all routers do) or you want to set up the 5 GHz extender network later, click the **Skip** button, and go to **Step 11** on page 23.

**10.** Enter the security settings for the existing 5 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   - If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (64 bit or 128 bit).
b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).

c. Next to the selected radio button, enter the network WEP key.

d. Click the Continue button.

Smart Setup displays the network names and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

11. Use the default extension names, or, in the Name (2.4GHz SSID) field, and, if you have set up a 5 GHz network, in the Name (5GHz SSID) field, enter new network names for your extender WiFi networks, and click the Continue button.

**Note:** If you do not want to use the same security modes for your extender networks as you use for your existing networks, clear the check box before you click the Continue button. You then can configure the security settings for the extender networks. However, you can also change the security settings later.

The extender applies the settings.

12. Wait a couple of minutes while the extender creates the WiFi networks.
When the extender is ready, Smart Setup summarizes the extender networks.

![NETGEAR genie](image)

Follow the instructions below to connect devices to the extended network.

13. Use a WiFi network manager on the computer or mobile device to connect to the extender’s newly created 2.4 GHz or 5 GHz WiFi network.

**Note:** Unless you entered a new network name in Step 11, the extender changes its default NETGEAR_EXT network name to the name of the WiFi network to which you connected the extender and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

**Note:** If your computer or mobile device cannot join the new WiFi network of the extender, see *Improve the Connection Between the Extender and the WiFi Router* on page 121.

14. Select the **My wireless devices are connected to the Extender network** check box, and click the **Continue** button.
Smart Setup describes the color of the Link Rate LED on the front of the extender. Because you placed the extender close the WiFi router, the Link Rate LED is green.

15. Click the **Finish** button.
   
   A pop-up screen displays.

16. To bookmark the URL of the extender, click the **OK** button.

17. If you are prompted to enter a user name and password, type **admin** for the user name and **password** for the password.
   
   The NETGEAR registration screen displays. You are now online.

18. To register the extender, enter your information in the fields onscreen, and click the **Register** button.
   
   A message displays, congratulating you that you have extended your network.

19. Close your browser.

20. Now that the extender is connected to the WiFi router and you can connect a computer or mobile device to the extender's WiFi network, move it to a location where you can boost your WiFi range.
   
   The location you choose must be within the range of your existing WiFi router network.

21. Plug the extender into an electrical outlet at the new location and restart the extender.

   Unless the extender is outside the range of your WiFi router, the extender connects automatically to the WiFi router.
The Link Rate LEDs help you choose a spot where the extender-to-router connection is optimal. The following tables describe how the LEDs show the quality of the connection.

### 2.4 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

### 5 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

If the Link Rate LED is off, the extender cannot connect to the WiFi router. If the Link Rate LED is red, the extender has a poor connection to the WiFi router.

22. If the extender has no connection or a poor connection, move the extender closer to your WiFi router and try again until the 2.4 GHz or 5 GHz Link Rate LED is green, or at least amber.

23. Use a WiFi network manager on the computer or mobile device to reconnect to the extender’s WiFi network.

**Note:** Unless you entered a new network name in **Step 11**, the extender changes its default NETGEAR_EXT network name to the name of the WiFi network to which you connected the extender and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

24. Select the new network and use your WiFi router password to connect.

You are now using your extended WiFi network.
Access the Extender over Ethernet and Use Smart Setup

If your WiFi router does not support WPS, you can use an Ethernet cable to connect your computer to one of the LAN ports of the extender. Then use the browser-based NETGEAR genie Smart Setup to connect the extender to an existing WiFi network.

After you have used Smart Setup to connect the extender to an existing WiFi network, the extender changes its default NETGEAR_EXT WiFi network name (SSID) in the 2.4 GHz band to the name of the existing WiFi network and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name, for example:

- **Existing network name.** MyNetworkName
- **New extended 2.4 GHz network name.** MyNetworkName_2GEXT
- **New extended 5 GHz network name.** MyNetworkName_5GEXT

---

**Note:** After you have set up the extender, you can also connect Ethernet-enabled devices such as gaming consoles and printers to the Ethernet LAN ports of the extender. For more information, see Connect Ethernet-Enabled Devices on page 73.

To access the extender from a computer over Ethernet and use Smart Setup to connect the extender to an existing WiFi network:

1. Place the extender close to the WiFi router.
   
   **Note:** In a later step in this procedure, after you have established a connection to the WiFi router, you can place the extender at its permanent location.

2. Plug the extender into an electrical outlet.

3. If necessary, press the **Power** button.
   
   The Device to Extender LED and the two Link Rate LEDs light amber during the startup process. After about one minute, these LEDs turn off.

4. Make sure that your computer is not connected to a WiFi network or Ethernet network.
   
   If the computer is already connected to a WiFi network or Ethernet network, you might not be able to connect to the extender.

5. Connect your computer to the extender with an Ethernet cable.
You can use any of the five Ethernet LAN ports of the extender.

**CAUTION:**

Do not use an Ethernet cable to connect the extender to a WiFi router. If you do so, the extender does not work because it is designed to use only a WiFi connection to a WiFi router.

6. If you have trouble connecting, try the following:
   - Wait a couple of minutes.
     
     If you start your computer, connect the Ethernet cable to the extender, and launch your browser quickly, the computer might still need a couple of minutes to recognize the Ethernet LAN connection before you can connect.
   - Make sure that your Ethernet cable is securely connected to the extender and the computer, and that the extender Device to Extender Connection LED lights.
     
     If the LED is not lit, reconnect the Ethernet cable, and relaunch your Internet browser.

7. Open a web browser window from the same computer.

   The browser takes you directly to the NETGEAR genie Smart Setup start screen.

   **Note:** If you are not automatically directed to the NETGEAR genie Smart Setup start screen, go to www.mywifxiext.net, and enter **admin** for the user name and **password** for the password.
Smart Setup searches for existing WiFi networks automatically and displays the networks in the 2.4 GHz band.

8. Select a 2.4 GHz WiFi network to extend, and click the **Continue** button.
9. Enter the security settings for the existing 2.4 GHz network:
   • If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   • If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (**Key 1**, **Key 2**, **Key 3**, or **Key 4**).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the **Continue** button.

If Smart Setup detects any networks in the 5 GHz band, it displays them.

10. Select a 5 GHz WiFi network to extend, and click the **Continue** button.

**Note:** If your router does not support the 5 GHz band (not all routers do) or you want to set up the 5 GHz extender network later, click the **Skip** button, and go to **Step 12** on page 32.
11. Enter the security settings for the existing 5 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the Password (network key) field, type the network passphrase (also called a password or network key).
     b. Click the Continue button.
   - If the network uses WEP, do the following:
     a. From the Encryption Strength menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the Continue button.

Smart Setup displays the network names and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.
12. Use the default extension names, or, in the **Name (2.4GHz SSID)** field, and, if you have set up a 5 GHz network, in the **Name (5GHz SSID)** field, enter new network names for your extender WiFi networks, and click the **Continue** button.

**Note:** If you do not want to use the same security modes for your extender networks as you use for your existing networks, clear the check box before you click the **Continue** button. You then can configure the security settings for the extender networks. However, you can also change the security settings later.

The extender applies the settings.

13. Wait a couple of minutes while the extender creates the WiFi networks.

When the extender is ready, Smart Setup summarizes the extender networks.

14. Use a WiFi network manager on the computer or mobile device to connect to the extender’s newly created 2.4 GHz or 5 GHz WiFi network.
Note: Unless you entered a new network name in Step 12, the extender changes its default NETGEAR_EXT network name to the name of the WiFi network to which you connected the extender and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

Note: If your computer or mobile device cannot join the new WiFi network of the extender, see Improve the Connection Between the Extender and the WiFi Router on page 121.

15. Select the My wireless devices are connected to the Extender network check box, and click the Continue button.

Smart Setup describes the color of the Link Rate LED on the front of the extender. Because you placed the extender close the WiFi router, the Link Rate LED is green.

16. Click the Finish button.

A pop-up screen displays.

17. To bookmark the URL of the extender, click the OK button.

18. If you are prompted to enter a user name and password, type admin for the user name and password for the password.

The NETGEAR registration screen displays. You are now online.

19. To register the extender, enter your information in the fields onscreen, and click the Register button.

A message displays, congratulating you that you have extended your network.

20. Close your browser.

21. Disconnect the Ethernet cable from the computer and the extender.

22. Now that the extender is connected to the WiFi router and you can connect a computer or mobile device to the extender’s WiFi network, move it to a location where you can boost your WiFi range.
The location you choose must be within the range of your existing WiFi router network.

23. Plug the extender into an electrical outlet at the new location and restart the extender. Unless the extender is outside the range of your WiFi router, the extender connects automatically to the WiFi router.

The Link Rate LEDs help you choose a spot where the extender-to-router connection is optimal. The following tables describe how the LEDs show the quality of the connection.

<table>
<thead>
<tr>
<th>2.4 GHz LED Status</th>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td><img src="2.4GHz" alt="LED Status" /></td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td><img src="2.4GHz" alt="LED Status" /></td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td><img src="2.4GHz" alt="LED Status" /></td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td><img src="2.4GHz" alt="LED Status" /></td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5 GHz LED Status</th>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both the Link Rate LED and the Device to Extender LED are green.</td>
<td><img src="5GHz" alt="LED Status" /></td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td>The Link Rate LED is amber and the Device to Extender LED is green.</td>
<td><img src="5GHz" alt="LED Status" /></td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td>The Link Rate LED is red.</td>
<td><img src="5GHz" alt="LED Status" /></td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td>The Link Rate LED is off.</td>
<td><img src="5GHz" alt="LED Status" /></td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

If the Link Rate LED is off, the extender cannot connect to the WiFi router. If the Link Rate LED is red, the extender has a poor connection to the WiFi router.

24. If the extender has no connection or a poor connection, move the extender closer to your WiFi router and try again until the 2.4 GHz or 5 GHz Link Rate LED is green, or at least amber.

25. Use a WiFi network manager on the computer or mobile device to reconnect to the extender’s WiFi network.

**Note:** Unless you entered a new network name in Step 12, the extender changes its default NETGEAR_EXT network name to the name of the WiFi network to which you connected the extender and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

26. Select the new network and use your WiFi router password to connect.

You are now using your extended WiFi network.
Manage the Extender Network and Security Settings

This chapter covers the following topics:

- Log In to the Extender After Initial Setup
- Change the Password
- Set Up Password Recovery
- Connect the Extender to a WiFi Network Without Using Smart Setup
- Connect the Extender to a Hidden WiFi Network
- Use WPS to Add a Computer to the Extender’s WiFi Network
- Manage the Extender WiFi Settings
- Change the Extender IP Address and Device Name
- Manage Advanced WiFi and WPS Settings
- Manage a WiFi Access List
- Set the Operating Mode to FastLane Technology
- Run Smart Setup Again After Initial Setup
- Connect Ethernet-Enabled Devices
Log In to the Extender After Initial Setup

You can log in to the extender to view or change the extender’s settings.

If you connect to the extender before it has been set up, the browser automatically goes to http://www.mywifiext.net and displays the NETGEAR genie Smart Setup screens, which step you through the setup process. For more information, see Access the Extender over WiFi and Use Smart Setup on page 19 or Access the Extender over Ethernet and Use Smart Setup on page 27.

To log in to the extender after initial setup:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and password for the password.

Note: NETGEAR recommends that you set a more secure password after you log in. For more information, see Change the Password on page 38.

The Status screen displays (see the following figure). Menu selections display on the left. The Status screen shows the current settings for the extender. The firmware version displays below the language menu.

For more information about the Status screen, see View the Status and Traffic Statistics of the Extender on page 81.

For information about upgrading firmware, see Update the Firmware on page 80.

4. To change your language, select a language from the menu in the top right of the screen. By default, the language selection is Auto, which means that the extender uses the language that it detects from the browser that you use.
Manage the Extender Network and Security Settings
Change the Password

The user name to access the extender is admin, and its default password is password. NETGEAR strongly recommends that you set a more secure password.

➢ To change the password for the extender:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and password for the password.
   If you already changed the password and want to change it again, type your personalized password.
4. Select Maintenance > Set Password.

   ![Set Password](image)

5. Type the old password.
6. Type the new password twice.
7. Click the Apply button.
   Your settings are saved.

Set Up Password Recovery

NETGEAR recommends that you enable password recovery if you change the password for the extender. Then you can recover the password if it is forgotten. This recovery process is supported in the Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.

➢ To set up password recovery:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net.
You are prompted to enter a user name and password.

3. Type **admin** for the user name and type your password.
   If you have not yet personalized your password, type **password** for the password.

4. Select **Maintenance > Set Password**.

5. Select the **Enable Password Recovery** check box.

6. Select two security questions and provide answers to them.

7. Click the **Apply** button.
   Your changes are saved.

### Connect the Extender to a WiFi Network Without Using Smart Setup

If you want to change the extender connection to another WiFi network, you can do so without using NETGEAR genie Smart Setup.

**Note:** You cannot use the following procedure to change the network names or security options for your extender WiFi networks. For information about how to change these settings, see *Manage the Extender WiFi Settings* on page 49.

- **To change the extender connection to another WiFi network without using Smart Setup:**
  1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
  2. In the address field of your browser, enter **www.mywifiext.net**.
     You are prompted to enter a user name and password.
  3. Type **admin** for the user name and type your password.
Manage the Extender Network and Security Settings

4. Select **Settings > Connect to Existing Network**.

The extender scans for existing WiFi networks and displays the networks in the 2.4 GHz band.

If you have not yet personalized your password, type **password** for the password.

5. Select the radio button for the 2.4 GHz network to which you want to connect the extender, and click the **Continue** button.

If your WiFi network is functioning but not on the list, your WiFi network might be hidden, or the connection between the WiFi router and the extender might be poor. For more information, see the following sections:

- **Connect the Extender to a Hidden WiFi Network** on page 43
- **Improve the Connection Between the Extender and the WiFi Router** on page 121
6. Enter the security settings for the existing 2.4 GHz network:
   • If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   • If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the **Continue** button.

If the extender detects any networks in the 5 GHz band, it displays them.

If your WiFi network is functioning but not on the list, your WiFi network might be hidden, or the connection between the WiFi router and the extender might be poor. For more information, see the following sections:

- *Connect the Extender to a Hidden WiFi Network* on page 43
- *Improve the Connection Between the Extender and the WiFi Router* on page 121

7. Select the radio button for the 5 GHz network to which you want to connect the extender, and click the **Continue** button.

**Note:** If your router does not support the 5 GHz band (not all routers do) or you do not yet want to change the 5 GHz network to which the extender connects, click the **Skip** button, and go to *Step 9* on page 71.
8. Enter the security settings for the existing 5 GHz network:

- If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
  a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
  b. Click the **Continue** button.

- If the network uses WEP, do the following:
  a. From the **Encryption Strength** menu, select the encryption strength (64 bit or 128 bit).
  b. Select the radio button that corresponds to the key that you want to use (**Key 1**, **Key 2**, **Key 3**, or **Key 4**).
  c. Next to the selected radio button, enter the network WEP key.
  d. Click the **Continue** button.

9. Wait about two minutes while the extender changes the WiFi network or networks.

10. Use a WiFi network manager on the computer or on a mobile device to reconnect to the extender's WiFi network.

   **Note:** If your computer or mobile device cannot join the new WiFi network of the extender, see *You Cannot Join a WiFi Network and Receive an Error Message* on page 120.

11. Click the **I have connected to the Extender network** button.

    The WiFi network settings for the extender are saved and the Status screen displays.
Connect the Extender to a Hidden WiFi Network

You can manually connect the extender to a hidden WiFi network without using NETGEAR genie Smart Setup.

Before you start the following procedure, you must know the name of the hidden WiFi network, the type of security that the network uses, and the key or passphrase to connect to the network.

**Note:** You cannot use the following procedure to change the network names or security options for your extender WiFi networks. For information about how to change these settings, see *Manage the Extender WiFi Settings* on page 49.

➢ **To connect the extender to a hidden WiFi network without using Smart Setup:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter `www.mywifiext.net`.
   You are prompted to enter a user name and password.
3. Type `admin` for the user name and type your password.
   If you have not yet personalized your password, type `password` for the password.
4. Select *Settings > Connect to Existing Network*.
   The extender scans for existing WiFi networks and displays the networks in the 2.4 GHz band.
5. Select the **Manually input my wireless SSID** radio button, and click the **Continue** button. The screen adjusts.

6. In the **Name (SSID)** field, enter the name of the 2.4 GHz network to which you want to connect the extender.

7. From the **Security** menu, select the security setting for the 2.4 GHz network. The screen adjusts.

8. Enter the security settings for the 2.4 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   - If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (**64 bit** or **128 bit**).
     b. Select the radio button that corresponds to the key that you want to use (**Key 1**, **Key 2**, **Key 3**, or **Key 4**).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the **Continue** button.

   If the extender detects any networks in the 5 GHz band, it displays them.

9. Select the **Manually input my wireless SSID** radio button, and click the **Continue** button.
Note: If your router does not support the 5 GHz band (not all routers do) or you do not want to connect the extender to a hidden 5 GHz network, click the Skip button, and go to Step 13 on page 46.

The screen adjusts.

10. In the Name (SSID) field, enter the name of the 5 GHz network to which you want to connect the extender.

11. From the Security menu, select the security setting for the 5 GHz network.

The screen adjusts.

12. Enter the security settings for the 5 GHz network:
   • If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the Password (network key) field, type the network passphrase (also called a password or network key).
     b. Click the Continue button.
   • If the network uses WEP, do the following:
     a. From the Encryption Strength menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the Continue button.
13. Wait about two minutes while the extender connects to the hidden WiFi network or networks.

14. Use a WiFi network manager on the computer or on a mobile device to reconnect to the extender’s WiFi network.

   **Note:** If your computer or mobile device cannot join the new WiFi network of the extender, see *You Cannot Join a WiFi Network and Receive an Error Message* on page 120.

15. Click the *I have connected to the Extender network* button.

   The WiFi network settings for the extender are saved and the Status screen displays.

**Use WPS to Add a Computer to the Extender’s WiFi Network**

WPS (Wi-Fi Protected Setup) lets you connect a computer or WiFi device to the extender’s network without entering the WiFi network passphrase or key. Instead, you use a WPS button or enter a PIN to connect.

If you use the Push Button method, the WiFi device that you are trying to connect must have a physical push button or a software push button. If you use the PIN method, you must know the PIN of the WiFi device that you are trying to connect.

WPS supports WPA and WPA2 WiFi security. If your extender network is open (no WiFi security is set), connecting with WPS automatically sets WPA + WPA2 WiFi security on the extender network and generates a random passphrase. You can view this passphrase on the Wireless Settings screen (for more information, see *Manage the Extender WiFi Settings* on page 49).

**Note:** For information about using WPS to connect the extender to a WiFi network during setup, see *Connect the Extender with WPS to a WiFi Network* on page 17.
Use WPS with the Push Button Method

To use the Push Button method to connect a WiFi device to the extender’s WiFi network, the WiFi device that you are trying to connect must have a physical push button or a software push button.

➢ To let a WiFi device join the extender’s WiFi network using WPS with the Push Button method:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net.
   You are prompted to enter a user name and password.
3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.
4. Select Add WPS Client.
   The screen displays a description of the WPS method.
5. Click the Next button.

By default, the Push Button (recommended) radio button is selected.

6. Either click the button onscreen or press the WPS button on the rear panel of the extender.
   Both Link Rate LEDs and the Device to Extender LED blink green for two minutes.
   For two minutes, the extender attempts to find the WiFi device (that is, the client) that you want to join the extender’s WiFi network.
7. Within two minutes, go to the WiFi device and press its WPS button (to join the extender’s WiFi network without entering a password).
8. To verify that the WiFi device is connected to the extender’s WiFi network, select Maintenance > Attached Devices.
   The WiFi device displays onscreen.
Use WPS with the PIN Method

To use the PIN method to connect a WiFi device to the extender’s WiFi network, you must know the PIN of the WiFi device that you are trying to connect.

To let a WiFi device join the extender’s WiFi network using WPS with the PIN method:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and type your password. If you have not yet personalized your password, type password for the password.
4. Select Add WPS Client. The screen displays a description of the WPS method.
5. Click the Next button. On the screen that displays, the Push Button (recommended) radio button is selected by default.
6. Select the PIN Number radio button.

7. In the Enter Client’s PIN field, enter the PIN number of the WiFi device.
8. Click the Next button. For four minutes, the extender attempts to find the WiFi device (that is, the client) that you want to join the extender’s WiFi network.
9. Within four minutes, go to the WiFi device and use its WPS software to join the network without entering a password.
To verify that the WiFi device is connected to the extender’s WiFi network, select **Maintenance > Attached Devices**.

The WiFi device displays onscreen.

**Manage the Extender WiFi Settings**

You can change the network name (SSID) for the extender’s network and set up WiFi security. If you did not change these settings already during initial setup, the network name is NETGEAR_EXT, and the network is open (no WiFi security is set up).

**Note:** Although the WiFi security of the extender’s network can be different from the WiFi security of the network that the extender is connected to, you typically would select the same type of WiFi security for both networks.

In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this happens, experiment with different channels to see which is the best.

When you use more than one WiFi router or access point, it is better if adjacent routers or access points use different channels to reduce interference. NETGEAR recommends a channel spacing of four channels between adjacent routers or access points (for example, use Channels 1 and 5, or 6 and 10).

**Note:** You can change the channel only if you have enabled FastLane Technology. For more information, see *Set the Operating Mode to FastLane Technology* on page 67. In normal operating mode (also referred to as Internet Surfing mode), you cannot change the channel.

**Note:** You can change the wireless mode in one radio band only if the extender is connected to the WiFi router in the other radio band. For example, you can change the wireless mode in the 2.4 GHz band only if the extender is connected to the WiFi router in the 5 GHz band. If the extender is connected to the WiFi router in the 2.4 GHz band, you cannot change the wireless mode in the 2.4 GHz band because the extender adapts the wireless mode that the WiFi router functions in.

➤ **To change the WiFi settings for the extender’s network:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter **www.mywifiext.net**. You are prompted to enter a user name and password.

3. Type **admin** for the user name and type your password. If you have not yet personalized your password, type **password** for the password.

4. Select Setting > Wireless.

5. Change the WiFi settings as described in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Region Selection</strong></td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>From the <strong>Region</strong> menu, select the region in which you operate the extender. Note: If you purchased the extender in the United States or Canada, the selection from the <strong>Region</strong> menu is <strong>North America</strong>. You cannot change this selection.</td>
</tr>
</tbody>
</table>
### Ethernet ports to WiFi use the following band

Specify if the Gigabit Ethernet ports on the rear panel of the extender connect to the 2.4 GHz band or the 5 GHz band by selecting one of the following radio buttons:

- **2.4GHz**. The Gigabit Ethernet ports connect to the 2.4 GHz WiFi band. This is the default setting.
- **5GHz**. The Gigabit Ethernet ports connect to the 5 GHz WiFi band.

### My EX6200 wireless network (2.4GHz)

#### Name (SSID)

In the Name (SSID) field, type a new name or use the name that the extender assigns by default:

- **Existing network name**. `MyNetworkName`
- **New extended 2.4 GHz network name**. `MyNetworkName_2GEXT`

If more than one extender operates in your neighborhood, changing the SSID makes it easier to identify the extenders.

#### Channel

From the Channel menu, select **Auto** for automatic channel selection, or select an individual channel.

**Note:** You can change the channel only if you have enabled FastLane Technology. For more information, see *Set the Operating Mode to FastLane Technology* on page 67.

**Note:** In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this happens, experiment with different channels to see which is the best.

#### Wireless mode

From the Wireless mode menu, select one of the following modes:

- **Up to 54 Mbps**. Legacy mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network, but limits 802.11n devices to function at up to 54 Mbps. If your network security is WEP, you must use the Up to 54 Mbps mode.
- **Up to 145 Mbps**. Neighbor friendly mode for reduced interference with neighboring wireless networks. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network, but limits 802.11n devices to function at up to 145 Mbps. This mode is the default mode in the 2.4 GHz band.
- **Up to 300 Mbps**. Performance mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network, and allows 802.11n devices to function at up to 300 Mbps.

**Note:** You can change the wireless mode in the 2.4 GHz band only if the extender is connected to the WiFi router in the 5 GHz band. If the extender is connected to the WiFi router in the 2.4 GHz band, the extender adapts the wireless mode that the WiFi router functions in and the Wireless mode menu is disabled.

**Note:** WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps.
## Security Options (2.4GHz)

Select the type of WiFi security that you want to use for the extender’s 2.4 GHz WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network.
- **WEP.** WEP is an older standard, and is less secure than WPA or WPA2. WEP limits the wireless mode to **Up to 54 Mbps.** WEP uses encryption keys and data encryption for data security. Select 64-bit or 128-bit encryption and enter a key. To join the extender’s WiFi network, a user must enter the key. For more information, see Configure WEP on page 55.
- **WPA-PSK [TKIP].** WPA is more secure than WEP. Enter a passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.
- **WPA2-PSK [AES].** WPA2 is even more secure than WEP, but some older WiFi devices do not detect WPA2. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.
- **WPA-PSK [TKIP] + WPA2-PASK [AES].** When your network includes WiFi devices that support either WPA or WPA2, select WPA-PSK [TKIP] + WPA2-PASK [AES] security. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.

## My EX6200 wireless network (5GHz)

**Name (SSID)**  
In the **Name (SSID)** field, type a new name or use the name that the extender assigns by default:

- **Existing network name.** MyNetworkName
- **New extended 5 GHz network name.** MyNetworkName_5GEXT
  
  If more than one extender operates in your neighborhood, changing the SSID makes it easier to identify the extenders.

**Channel**  
From the **Channel** menu, select **Auto** for automatic channel selection, or select an individual channel.

**Note:** You can change the channel only if you have enabled FastLane Technology. For more information, see Set the Operating Mode to FastLane Technology on page 67.

**Note:** In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this happens, experiment with different channels to see which is the best.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security Options (2.4GHz)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Select the type of WiFi security that you want to use for the extender’s 2.4 GHz WiFi network:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>None.</strong> An open WiFi network that does not provide any security. Any WiFi device can join the network.</td>
<td></td>
</tr>
<tr>
<td><strong>WEP.</strong> WEP is an older standard, and is less secure than WPA or WPA2. WEP limits the wireless mode to <strong>Up to 54 Mbps.</strong> WEP uses encryption keys and data encryption for data security. Select 64-bit or 128-bit encryption and enter a key. To join the extender’s WiFi network, a user must enter the key. For more information, see Configure WEP on page 55.</td>
<td></td>
</tr>
<tr>
<td><strong>WPA-PSK [TKIP].</strong> WPA is more secure than WEP. Enter a passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.</td>
<td></td>
</tr>
<tr>
<td><strong>WPA2-PSK [AES].</strong> WPA2 is even more secure than WEP, but some older WiFi devices do not detect WPA2. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.</td>
<td></td>
</tr>
<tr>
<td><strong>WPA-PSK [TKIP] + WPA2-PASK [AES].</strong> When your network includes WiFi devices that support either WPA or WPA2, select WPA-PSK [TKIP] + WPA2-PASK [AES] security. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.</td>
<td></td>
</tr>
<tr>
<td><strong>My EX6200 wireless network (5GHz)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Name (SSID)</strong></td>
<td>In the <strong>Name (SSID)</strong> field, type a new name or use the name that the extender assigns by default:</td>
</tr>
<tr>
<td><strong>Existing network name.</strong> MyNetworkName</td>
<td></td>
</tr>
<tr>
<td><strong>New extended 5 GHz network name.</strong> MyNetworkName_5GEXT</td>
<td>If more than one extender operates in your neighborhood, changing the SSID makes it easier to identify the extenders.</td>
</tr>
<tr>
<td><strong>Channel</strong></td>
<td>From the <strong>Channel</strong> menu, select <strong>Auto</strong> for automatic channel selection, or select an individual channel.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can change the channel only if you have enabled FastLane Technology. For more information, see Set the Operating Mode to FastLane Technology on page 67.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this happens, experiment with different channels to see which is the best.</td>
<td></td>
</tr>
</tbody>
</table>
### Wireless mode

From the Wireless mode menu, select one of the following modes:

- **Up to 54 Mbps.** Legacy mode. This mode allows 802.11ac, 802.11an, and 802.11a devices to join the network, but limits 802.11ac and 802.11n devices to function at up to 54 Mbps. If your network security is WEP, you must use the Up to 54 Mbps mode.

- **Up to 174 Mbps.** Neighbor friendly mode for reduced interference with neighboring wireless networks. This mode allows 802.11ac, 802.11an, and 802.11a devices to join the network, limits 802.11ac to function at up to 174 Mbps, and limits 802.11an devices to function at up to 150 Mbps.

- **Up to 400 Mbps.** Performance mode for networks with many 802.11n devices. This mode has a bandwidth of 40 MHz, allows 802.11ac, 802.11an, and 802.11a devices to join the network, limits 802.11ac to function at up to 400 Mbps, and allows 802.11an devices to function at up to 300 Mbps.

- **Up to 867 Mbps.** Performance mode for networks with many 802.11ac devices. This mode has a bandwidth of 80 MHz, allows 802.11ac, 802.11an, and 802.11a devices to join the network, allows 802.11ac devices to function at up to 867 Mbps, and allows 802.11an devices to function at up to 300 Mbps. This mode is the default mode in the 5 GHz band.

**Note:** You can change the wireless mode in the 5 GHz band only if the extender is connected to the WiFi router in the 2.4 GHz band. If the extender is connected to the WiFi router in the 5 GHz band, the extender adapts the wireless mode that the WiFi router functions in and the Wireless mode menu is disabled.

**Note:** WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps.

### Security Options (5GHz)

Select the type of WiFi security that you want to use for the extender’s 5 GHz WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network.

- **WEP.** WEP is an older standard, and is less secure than WPA or WPA2. WEP limits the wireless mode to **Up to 54 Mbps.** WEP uses encryption keys and data encryption for data security. Select 64-bit or 128-bit encryption and enter a key. To join the extender’s WiFi network, a user must enter the key. For more information, see Configure WEP on page 55.

- **WPA-PSK [TKIP].** WPA is more secure than WEP. Enter a passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.

- **WPA2-PSK [AES].** WPA2 is even more secure than WEP, but some older WiFi devices do not detect WPA2. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.

- **WPA-PSK [TKIP] + WPA2-PSK [AES].** When your network includes WiFi devices that support either WPA or WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security. Enter a passphrase. To join the extender’s WiFi network, a user must enter the passphrase. For more information, see Configure WPA, WPA2, or WPA + WPA2 on page 54.

---

**CAUTION:**

If you use a WiFi device to change the extender’s WiFi settings, you are disconnected when you click the **Apply** button. To reconnect, you must select the new network name that you created, and enter the passphrase or WiFi security key that you set up.
6. Click the **Apply** button.
   The extender applies your settings, which might take up to one minute.

7. If you are disconnected, reconnect your WiFi device to the extender’s network with its new settings.
   Use a WiFi network manager on the computer or on a mobile device to reconnect to the extender’s WiFi network.

   **Note:** If your computer or mobile device cannot join the new WiFi network of the extender, see *You Cannot Join a WiFi Network and Receive an Error Message* on page 120.

8. Click the **I have connected to the Extender network** button.
   The WiFi network settings for the extender are saved and the Status screen displays.

**Configure WPA, WPA2, or WPA + WPA2**

Both WPA and WPA2 provide strong data security. WPA2 with AES is a hardware implementation. If you want to use WPA2 security, make sure that all devices in your WiFi network support WPA2 security. If you are not sure, use WPA + WPA2 security.

---

**Note:** WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps. NETGEAR recommends that you use WPA2-PSK security, which supports the maximum speed that your devices are capable of.

---

The process to configure WPA, WPA2, or WPA + WPA2 security is the same for the 2.4 GHz and 5 GHz bands.

➢ **To configure WPA, WPA2, or WPA + WPA2 in the extender:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter **www.mywifiext.net**.
   You are prompted to enter a user name and password.

3. Type **admin** for the user name and type your password.
   If you have not yet personalized your password, type **password** for the password.
4. Select **Settings > Wireless**.

5. Scroll down to either the Security Options (2.4GHz) section (shown in the previous figure) or the Security Options (5GHz) section, and select the **WPA-PSK [TKIP]**, **WPA2-PSK [AES]**, or **WPA-PSK [TKIP] + WPA2-PSK [AES]** radio button.

6. In the **PassPhrase** field, enter the passphrase.

7. Click the **Apply** button.

   Your settings are saved.

8. If you are disconnected, reconnect your WiFi device to the extender’s network with its new settings.

   Smart Setup can guide you through this process. For more information, see *Run Smart Setup Again After Initial Setup* on page 69.

### Configure WEP

WEP is legacy WiFi security that limits the wireless mode to the **Up to 54 Mbps** selection, irrespective of whether you use the 2.4 GHz band or the 5 GHz band. Unless your WiFi network includes devices that do not support WPA2 or WPA security, NETGEAR recommends that you use WPA2, WPA, or WPA + WPA2 security.

---

**Note:** WPS does not support WEP security. If you change the security to WEP, you can no longer let WiFi devices join the extender’s WiFi network by using WPS.

---

The process to configure WEP security is the same for the 2.4 GHz and 5 GHz bands.
To set up WEP:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter `www.mywifiext.net`.

   You are prompted to enter a user name and password.
3. Type `admin` for the user name and type your password.

   If you have not yet personalized your password, type `password` for the password.
5. Scroll down to either the Security Options (2.4GHz) section (shown in the following figure) or the Security Options (5GHz) section, and select the `WEP` radio button.

   ![Wireless Settings](image)

   6. From the **Encryption Strength** menu, select the encryption strength setting:

      - **64 bit**. Requires an encryption key of 10 hexadecimal digits (any combination of 0–9, a–f, or A–F) or a string of five characters.
      - **128 bit**. Requires an encryption key of 26 hexadecimal digits (any combination of 0–9, a–f, or A–F) or a string of 13 characters.

   7. Specify the active key by selecting the **Key 1**, **Key2**, **Key3**, or **Key 4** radio button.

   Only one key can be the active key.

   8. Enter a key next to the selected radio button.
The size of the key depends on your selection from the **Encryption Strength** menu (64 bit or 128 bit). The key values are not case-sensitive.

9. Click the **Apply** button.
   Your settings are saved.

10. If you are disconnected, reconnect your WiFi device to the extender’s network with its new settings.
    Smart Setup can guide you through this process. For more information, see [*Run Smart Setup Again After Initial Setup*](#) on page 69.

### Change the Extender IP Address and Device Name

By default, the extender receives its IP address automatically from the WiFi router to which it connects. If the WiFi router does not have a DHCP server or its DHCP server is disabled, you can assign a static IP address to the extender.

Before you assign a static IP address, you must know the IP address range, subnet mask, gateway IP address, and primary DNS server of your network.

**CAUTION:**

NETGEAR recommends that you change the IP address of the extender only if you are technically experienced or have a technically experienced person to help you. Incorrect configuration can prevent you from connecting to the extender and might require you to reset the extender to factory default settings.

You can also change the extender device name, which is the name by which the extender is known in the network.

- **To change the IP address of the extender to a static IP address and specify a new device name:**
  1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
  2. In the address field of your browser, enter **[www.mywifiext.net](http://www.mywifiext.net)**.
     You are prompted to enter a user name and password.
  3. Type **admin** for the user name and type your password.
     If you have not yet personalized your password, type **password** for the password.
4. Select extender **Settings > IP Address**.

5. To change the name, type a name in the **Device Name** field. By default, the device name is **EX6200**.

6. Select the **Use Static IP Address** radio button.

7. Specify the static IP address settings:
   - **IP Address**. The static IP address to be assigned to the extender.
   - **IP Subnet Mask**. The subnet mask associated with the IP address.
   - **Gateway IP Address**. The IP address for the gateway for your WiFi network.
   - **Primary DNS**. The primary domain name server (DNS) for your WiFi network.

8. Click the **Apply** button.
   Your settings are saved, and you are disconnected from the extender.

9. To continue to configure the extender, reconnect to the extender using the new IP address.

**Manage Advanced WiFi and WPS Settings**

The extender is already configured with the optimum settings. Do not change the advanced settings unless directed by NETGEAR support. Incorrect settings might disable the extender unexpectedly.

- **To view or change the advanced WiFi and WPS settings:**
  1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
  2. In the address field of your browser, enter **www.mywifiext.net**.
     You are prompted to enter a user name and password.
  3. Type **admin** for the user name and type your password.
     If you have not yet personalized your password, type **password** for the password.
4. Select **Advanced > Wireless Settings.**

![Advanced Wireless Settings]

5. View or change the following settings as described in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advanced Wireless Settings</strong></td>
<td><strong>Enable Wireless Access Point (2.4GHz)</strong> By default, the extender functions as a WiFi access point in the 2.4 GHz band. Clear the List wireless access point (2.4GHz) check box only if you want to prevent WiFi devices from connecting to the extender in the 2.4 GHz band. LAN devices can still connect to the extender over an Ethernet cable. <strong>Enable SSID Broadcast (2.4GHz)</strong> By default, the extender broadcasts its WiFi network name (SSID) for the 2.4 GHz band. Clear the List SSID broadcast (2.4GHz) check box only to hide the network name of the extender in the 2.4 GHz band. In such a situation, the network name of the extender does not display in a WiFi network manager. A user who wants to join the hidden WiFi network of the extender must know its network name. <strong>Enable Wireless Access Point (5GHz)</strong> By default, the extender functions as a WiFi access point in the 5 GHz band. Clear the List wireless access point (5GHz) check box only if you want to prevent WiFi devices from connecting to the extender in the 5 GHz band. LAN devices can still connect to the extender over an Ethernet cable. <strong>Enable SSID Broadcast (5GHz)</strong> By default, the extender broadcasts its WiFi network name (SSID) for the 5 GHz band. Clear the List SSID broadcast (5GHz) check box only to hide the network name of the extender in the 5 GHz band. In such a situation, the network name of the extender does not display in a WiFi network manager. A user who wants to join the hidden WiFi network of the extender must know its network name. <strong>WPS Settings</strong> <strong>Extender’s PIN</strong> This is a fixed field that shows the extender’s PIN.</td>
</tr>
</tbody>
</table>
### Manage a WiFi Access List

By default, any WiFi device that is configured with the correct network name (SSID) can access the WiFi network of the extender. For increased security, you can restrict access to the WiFi network of the extender to allow only specific WiFi devices based on their MAC addresses. Devices that are not on the access list cannot join the WiFi network of the extender.

#### Setting | Description
---|---
Enable Device’s PIN | By default, the Enable Device’s PIN check box is selected and the extender’s PIN is enabled. For enhanced security, you can disable the extender’s PIN by clearing the Enable Device’s PIN check box. However, when you disable the extender’s PIN, WPS is not disabled because you can still use the physical WPS button.  
**Note:** The PIN function might temporarily be disabled when the extender detects suspicious attempts to break into the extender’s WiFi settings by using the extender’s PIN through WPS.

Prevent PIN compromise | By default, automatic disabling of the PIN is turned on, and the PIN is disabled after three failed PIN connections. In this situation, the WPS LED blinks slowly. When you restart the extender, the PIN is reenabled.  
To turn off automatic disabling of the PIN, clear the check box below the Enable Device’s PIN check box. You can change this setting only when the PIN is enabled.  
To change the number of times that a PIN connection is allowed to fail, enter a number in the field. You can change this number only when the PIN is enabled.

Keep Existing Wireless Settings (2.4GHz b/g/n) | By default, the settings on the Wireless Settings screen remain the same when you use WPS to establish a WiFi connection in the 2.4 GHz band. Clear the Keep Existing Wireless Settings (2.4GHz b/g/n) check box only if you want to allow the WPS process to change the SSID and passphrase for access in the 2.4 GHz band on the Wireless Settings screen.

Keep Existing Wireless Settings (5GHz a/n/ac) | By default, the settings on the Wireless Settings screen remain the same when you use WPS to establish a WiFi connection in the 5 GHz band. Clear the Keep Existing Wireless Settings (5GHz a/n/ac) check box only if you want to allow the WPS process to change the SSID and passphrase for access in the 5 GHz band on the Wireless Settings screen.

**Note:** If you clear a Keep Existing Wireless Settings check box and use WPS to add a computer or WiFi device to the extender’s network, the SSID and passphrase are automatically generated and other devices that are already connected to the extender’s network might be disconnected. You can view the SSID and passphrase on the Wireless Settings screen (see Manage the Extender WiFi Settings on page 49). NETGEAR recommends that you keep the Keep Existing Wireless Settings check boxes selected.

6. Click the **Apply** button.  
Your changes are saved.
Each network device has a MAC address, which is a unique 12-character physical address, containing the hexadecimal characters 0–9, a–f, or A–F only, and separated by colons (for example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the label of the WiFi device. If you do not have access to the label, you can display the MAC address using the network configuration utilities of the computer. You might also find the MAC addresses on the Network Devices screen (see View the Wired and WiFi Network Devices on page 85).

**CAUTION:**

If you use a WiFi device to set up the access list, add your WiFi device to the access list. Otherwise, you are disconnected when you click the **Apply** button. To avoid this situation, use a computer with a wired connection to access the extender.

**Set Up and Enable the Access List**

Before you can enable the access list, you must add the MAC addresses of the WiFi devices that you want to grant access to the WiFi network of the extender.

➢ **To set up and enable the access list:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter **www.mywifiext.net**.
   You are prompted to enter a username and password.
3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.
5. Click the **Setup Access List** button.

If you have not yet added any WiFi devices, the Wireless Card Access List is empty.

6. Click the **Add** button.

The Available Wireless Cards table displays the name and MAC address of WiFi devices that are connected to the extender.

7. Select a device by one of the following methods:

   • Select a device from the table by selecting its associated radio button. The **Device Name** and **MAC Address** fields are automatically populated.

   • Enter a device name and MAC address manually:
     
     a. In the **Device Name** field, type a name for the WiFi device.
     
     b. In the **MAC Address** field, type the MAC address of the WiFi device.

8. Click the **Apply** button.
The WiFi device is added to the Wireless Card Access List.

9. To add more WiFi devices, repeat Step 6 through Step 8.

10. Select the Turn Access Control On check box.

**CAUTION:**
If you use a WiFi device to set up the access list, add your WiFi device to the access list. Otherwise, you are disconnected when you click the Apply button.

11. Click the Apply button.
Now only WiFi devices that are in the Wireless Card Access List can access the WiFi network of the extender.

**Disable the Access List**
If you decide that you no longer need an access list on the extender, you can disable the access list.

➢ **To disable the access list:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter www.mywifiext.net.
You are prompted to enter a user name and password.

3. Type admin for the user name and type your password.
If you have not yet personalized your password, type password for the password.

5. Click the Setup Access List button.

6. Clear the Turn Access Control On check box.

7. Click the Apply button.

Now any WiFi device can access the WiFi network of the extender.

Change a Device on the Access List

You can change the name or MAC address of a device on the access list.

To change a WiFi device on the access list:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter www.mywifiext.net.

   You are prompted to enter a user name and password.

3. Type admin for the user name and type your password.

   If you have not yet personalized your password, type password for the password.
4. Select **Advanced > Wireless Settings**.

![Advanced Wireless Settings](image)

5. Click the **Setup Access List** button.

![Wireless Card Access List](image)

6. Select the radio button to the left of the device that you want to change.
7. Click the **Edit** button.

![Wireless Card Access List](image)

8. Change the name of the device or the MAC address.
9. Click the **Apply** button.

The changed settings display in Wireless Card Access List.

---

**Manage the Extender Network and Security Settings**

65
Remove a Device from the Access List

If you no longer want to grant a device access to the WiFi network of the extender, you can remove the device from the access list.

➢ To remove a WiFi device from the access list:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter www.mywifiext.net.
   You are prompted to enter a user name and password.

3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.


5. Click the Setup Access List button.

6. Select the radio button to the left of the device that you want to remove.

7. Click the Delete button.
   The device is removed from the Wireless Card Access List.
Set the Operating Mode to FastLane Technology

The normal operating mode of the extender (also referred to as Internet Surfing mode) is to allow devices on both 2.4 GHz and 5 GHz bands to connect at the same time. This mode extends both WiFi bands at the same time, but reduces the WiFi performance.

FastLane Technology offers maximum WiFi performance. It provides high-speed WiFi with a dedicated band connecting the extender and the WiFi device, and a second band connecting the extender and the WiFi router. FastLane Technology is ideal for HD gaming and HD video streaming.

**Note:** If all your devices and your WiFi router support only the 2.4 GHz band, or all your devices and your WiFi router support only the 5 GHz band, do not enable FastLane Technology.

When you enable FastLane Technology, you have two options:

- **Use the 2.4 GHz band to connect the extender to the WiFi devices and use the 5 GHz band to connect the extender to the WiFi router.** Use this mode if your WiFi router supports the 5 GHz band but the devices that you want to use for gaming and streaming support the 2.4 GHz band.
- **Use the 5 GHz band to connect the extender to the WiFi devices and use the 2.4 GHz band to connect the extender to the WiFi router.** Use this mode if the devices that you want to use for gaming and streaming support the 5 GHz band but your WiFi router supports the 2.4 GHz band.

➢ **To enable FastLane Technology:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter `www.mywifiext.net`. You are prompted to enter a user name and password.
3. Type `admin` for the user name and type your password.
   - If you have not yet personalized your password, type `password` for the password.
4. Select **Advanced > Operating Mode**.

5. By default, the **Internet Surfing** radio button is selected.

6. Select the **FastLane Technology** radio button.

7. Select the FastLane Technology option that you want to enable by selecting one of the following radio buttons:
   - **Device-to-extender in 5GHz only and extender-to-router in 2.4GHz only**.
     Your WiFi devices must support the 5 GHz band.
   - **Device-to-extender in 2.4GHz only and extender-to-router in 5GHz only (Router must support 5GHz band)**.
     Your WiFi router must support the 5 GHz band. This option is enabled by default.

8. Click **Apply**.

   Your settings are saved.

9. If you are disconnected, reconnect your WiFi device to the extender’s network with its new settings.

   For example, if you were connected to the extender’s network in the 2.4 GHz band, you now might have to connect in the 5 GHz band, or the other way around.
Run Smart Setup Again After Initial Setup

There might be situations in which you want to run NETGEAR genie Smart Setup again after the initial setup.

➢ **To run Smart Setup again:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter **www.mywifext.net**.
   You are prompted to enter a user name and password.

3. Type **admin** for the user name and type your password.
   If you have not yet personalized your password, type **password** for the password.

4. Select **Smart Setup**.

Smart Setup searches for existing WiFi networks automatically and displays the networks in the 2.4 GHz band.
5. Select a 2.4 GHz WiFi network to extend, and click the **Continue** button.

![Extender-to-Router settings menu]

6. Enter the security settings for the existing 2.4 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the **Password (network key)** field, type the network passphrase (also called a password or network key).
     b. Click the **Continue** button.
   - If the network uses WEP, do the following:
     a. From the **Encryption Strength** menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the **Continue** button.

If Smart Setup detects any networks in the 5 GHz band, it displays them.

![Extender-to-Router settings menu]

7. Select a 5 GHz WiFi network to extend, and click the **Continue** button.
Note: If your router does not support the 5 GHz band (not all routers do) or you want to set up the 5 GHz extender network later, click the Skip button, and go to Step 9 on page 71.

8. Enter the security settings for the existing 5 GHz network:
   - If the network uses WPA-PSK, WPA2-PSK, or a combination of these options, do the following:
     a. In the Password (network key) field, type the network passphrase (also called a password or network key).
     b. Click the Continue button.
   - If the network uses WEP, do the following:
     a. From the Encryption Strength menu, select the encryption strength (64 bit or 128 bit).
     b. Select the radio button that corresponds to the key that you want to use (Key 1, Key 2, Key 3, or Key 4).
     c. Next to the selected radio button, enter the network WEP key.
     d. Click the Continue button.

Smart Setup displays the network names and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

9. Use the default extension names, or, in the Name (2.4GHz SSID) field, and, if you have set up a 5 GHz network, in the Name (5GHz SSID) field, enter new network names for your extender WiFi networks, and click the Continue button.
**Note:** If you do not want to use the same security modes for your extender networks as you use for your existing networks, clear the check box before you click the **Continue** button. You then can configure the security settings for the extender networks. However, you can also change the security settings later.

The extender applies the settings.

10. Wait a couple of minutes while the extender creates the WiFi networks.

When the extender is ready, Smart Setup summarizes the extender networks.

11. Use a WiFi network manager on the computer or mobile device to connect to the extender’s newly created 2.4 GHz or 5 GHz WiFi network.

**Note:** Unless you entered a new network name in **Step 9**, the extender changes its default NETGEAR_EXT network name to the name of the WiFi network to which you connected the extender and adds _2GEXT to the end of the 2.4 GHz network name and _5GEXT to the end of the 5 GHz network name.

**Note:** If your computer or mobile device cannot join the new WiFi network of the extender, see *Improve the Connection Between the Extender and the WiFi Router* on page 121.
12. Select the **My wireless devices are connected to the Extender network** check box, and click the **Continue** button.

Smart Setup describes the color of the Link Rate LED on the front of the extender. Because you placed the extender close the WiFi router, the Link Rate LED is green.

13. Click the **Finish** button.

A pop-up screen displays.

14. To bookmark the URL of the extender, click the **OK** button.

A NETGEAR website displays. You are now online.

**Connect Ethernet-Enabled Devices**

You can use the extender to connect as many as five Ethernet-enabled devices, such as smart TVs, game consoles, and Blu-ray players, to the WiFi network.

After you have set up the extender, plug the Ethernet cable from a device that you want to connect directly into one of the extender’s Gigabit Ethernet LAN ports.

By default, the Gigabit Ethernet ports connect to the 2.4 GHz WiFi band. For information about how to change the connection to the 5 GHz WiFi band, see *Manage the Extender WiFi Settings* on page 49.
Figure 10. Gigabit Ethernet LAN ports on the rear panel
Maintain and Monitor the Extender

This chapter covers the following topics:

- Recover the admin Password
- Back Up and Manage the Extender Configuration
- Return the Extender to Its Factory Default Settings
- Update the Firmware
- View the Status and Traffic Statistics of the Extender
- View the Wired and WiFi Network Devices
Recover the admin Password

If you have changed the password to access the extender and have set up password recovery, you can recover your password if you have lost it. For information about setting up password recovery, see Set Up Password Recovery on page 38.

If you did not set up password recovery and have lost your password, you must reset the extender to factory default settings (see Use the Restore Factory Settings Button on page 79).

➢ To recover your password to access the extender:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifext.net.
   You are prompted to enter a user name and password.
3. Click the Cancel button.
   If password recovery is enabled, you are prompted to enter the serial number of the extender. The serial number is on the product label.
4. Enter the serial number of the extender.
5. Click the Continue button.
   A screen displays requesting the answers to your security questions.
6. Enter the saved answers to your security questions.
7. Click the Continue button.
   A screen displays confirming a successful recovery of your password.
8. Click the Login again button.
   A login screen displays.
9. With your recovered password, log in to the extender.

Back Up and Manage the Extender Configuration

When the extender works correctly after initial setup, NETGEAR recommends that you back up the extender configuration settings. After you have backed up the settings, if you have changed the extender configuration settings but are not content with the new settings, you can restore the extender configuration to the backed-up settings.
Back Up the Configuration Settings

You can back up the configuration file of the extender.

➢ To back up the extender configuration settings:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net.
   You are prompted to enter a user name and password.
3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.
4. Select extender Maintenance > Backup Settings.

   ![Backup Settings Screen](image)

5. Click the Backup button.
   Your browser extracts the configuration file from the extender. By default, the name of the backup file is NETGEAR_Ex6200.cfg.
6. If you do not have your browser set up to save downloaded files automatically, locate where you want to save the file.

Restore the Configuration Settings

You can restore the configuration file of the extender to a previously saved configuration file.

➢ To restore the extender configuration settings:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net.
   You are prompted to enter a user name and password.
3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.
4. Select extender **Maintenance > Backup Settings.**

![Backup Settings](image)

5. Click the **Browse** button.
6. Locate and select the previously saved backup file.

   By default, the name of the backup file is **NETGEAR_EX6200.cfg**.

   **CAUTION:**
   
   After you click the **Restore** button, do not try to go online, turn off the extender, shut down the computer, or do anything else to the extender until it finishes restarting!

7. Click the **Restore** button.
   
   A confirmation pop-up screen displays.

8. Confirm your decision.
   
   The extender restarts. This process takes about one minute.

**Return the Extender to Its Factory Default Settings**

Under some circumstances (for example, if you have lost track of the changes that you made to the extender settings), you might want to erase the configuration and reset it to factory default settings.

To reset the extender to factory default settings, you can use either the Restore Factory Settings button on the rear panel or the Erase function. However, if you have lost the password to access the extender, you must use the Restore Factory Settings button.

For a list of factory default settings, see *Factory Default Settings* on page 123.
Use the Restore Factory Settings Button

CAUTION:
This process erases any settings that you have configured in the extender.

➢ To reset the extender to factory default settings:

1. Insert a straightened paper clip into the hole of the Restore Factory Settings button and hold it for about seven seconds.

2. Release the button.
   The extender resets and restarts. This process takes about one minute.

Erase the Extender Configuration Settings

CAUTION:
This process erases any settings that you have configured in the extender.

➢ To erase the extender’s settings:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifext.net.
   You are prompted to enter a user name and password.
3. Type admin for the user name and type your password.
If you have not yet personalized your password, type `password` for the password.

4. Select **Maintenance > Backup Settings**.

   ![](image.png)

   **CAUTION:**

   After you click the **Erase** button, do not try to go online, turn off the extender, shut down the computer, or do anything else to the extender until it finishes restarting!

5. Click the **Erase** button.
   A confirmation pop-up screen displays.

6. Confirm your decision.
   The extender restarts. This process takes about one minute.

### Update the Firmware

Unless you changed the settings in the Firmware Update screen previously, the extender is set up to check for new firmware automatically at login.

➢ **To check manually for new firmware and, if available, update the firmware:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.

2. In the address field of your browser, enter `www.mywifiext.net`.
   You are prompted to enter a user name and password.

3. Type `admin` for the user name and type your password.
   If you have not yet personalized your password, type `password` for the password.
4. Select **Maintenance > Firmware Update**.

5. Click the **Check** button.

6. If new firmware is available, follow the onscreen prompts to download it onto your computer.

   **Note:** You might need to unzip the firmware file.

7. Click the **Browse** button.

8. Locate and select the new firmware file.

   The firmware file has a `.chk` extension.

   **CAUTION:**

   After you click the **Upload** button, do not try to go online, turn off the extender, shut down the computer, or do anything else to the extender until it finishes restarting!

9. Click the **Upload** button.

   The firmware update starts and the extender restarts. The firmware update process takes a couple of minutes.

**View the Status and Traffic Statistics of the Extender**

The Status screen displays when you log in to the extender after initial setup. The Status screen shows the current settings for the extender and provides access to the traffic statistics, such as the number of packets sent and number of packets received for each port.

- **To view the status of the extender, to view the traffic statistics, and to change the poll interval:**

  1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
  2. In the address field of your browser, enter **www.mywifext.net**.

     You are prompted to enter a user name and password.
3. Type **admin** for the user name and type your password. If you have not yet personalized your password, type **password** for the password.

4. Select **Maintenance > Status**.

---

The following table describes the fields on the Status screen.

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Version</td>
<td>The hardware version of the extender.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>The current firmware version of the extender. If you upgrade the firmware, this field changes.</td>
</tr>
<tr>
<td>GUI Language Version</td>
<td>The language version that is set on the extender. If you upgrade the firmware, this field might change.</td>
</tr>
</tbody>
</table>
### Maintain and Monitor the Extender

#### AC1200 WiFi Range Extender

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Status to Existing Network (2.4GHz)</strong></td>
<td></td>
</tr>
<tr>
<td>Name (SSID)</td>
<td>The name (SSID) of the WiFi network in the 2.4 GHz band to which the extender is connected.</td>
</tr>
<tr>
<td>Link Rate</td>
<td>The combined transmission (Tx) and receive (Rx) link rate in Mbps of the current WiFi connection in the 2.4 GHz band.</td>
</tr>
<tr>
<td>Signal Strength</td>
<td>The signal strength that the extender detects for the WiFi network in the 2.4 GHz band.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Shows whether the extender is connected to the WiFi network in the 2.4 GHz band. If the extender is disconnected from the WiFi network in the 2.4 GHz band, a Connect button displays. Click the Connect button connect the extender to the WiFi network in the 2.4 GHz band.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The extender can be connected simultaneously to a network in the 2.4 GHz band and to a network in the 5 GHz band. If you have a dual band WiFi router, the router can broadcast the same network name (SSID) simultaneously in both bands.</td>
</tr>
<tr>
<td><strong>Connection Status to Existing Network (5GHz)</strong></td>
<td></td>
</tr>
<tr>
<td>Name (SSID)</td>
<td>The name (SSID) of the WiFi network in the 5 GHz band to which the extender is connected.</td>
</tr>
<tr>
<td>Link Rate</td>
<td>The combined transmission (Tx) and receive (Rx) link rate in Mbps of the current WiFi connection in the 5 GHz band.</td>
</tr>
<tr>
<td>Signal Strength</td>
<td>The signal strength that the extender detects for the WiFi network in the 5 GHz band.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>Shows whether the extender is connected to the WiFi network in the 5 GHz band. If the extender is disconnected from the WiFi network in the 5 GHz band, a Connect button displays. Click the Connect button connect the extender to the WiFi network in the 5 GHz band.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The extender can be simultaneously connected to a network in the 5 GHz band and to a network in the 2.4 GHz band. If you have a dual band WiFi router, the router can broadcast the same network name (SSID) simultaneously in both bands.</td>
</tr>
<tr>
<td><strong>Extender IP Info</strong></td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>The physical address of the extender.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the extender. The default is 192.168.1.250.</td>
</tr>
<tr>
<td>DHCP Client</td>
<td>Shows whether the DHCP client of the extender is on.</td>
</tr>
<tr>
<td>IP Subnet Mask</td>
<td>The IP subnet mask that is associated with the IP address of the extender. The default is 255.255.255.0.</td>
</tr>
<tr>
<td>Gateway IP Address</td>
<td>The IP address of the WiFi network gateway.</td>
</tr>
<tr>
<td>Domain Name Server</td>
<td>The IP address of the Domain Name Server (DNS) of the WiFi network.</td>
</tr>
</tbody>
</table>
Maintain and Monitor the Extender

5. Click the **Show Statistics** button.

### Show Statistics

<table>
<thead>
<tr>
<th>Port</th>
<th>Status</th>
<th>TxPkts</th>
<th>RxPkts</th>
<th>Collisions</th>
<th>Tx B/s</th>
<th>Rx B/s</th>
<th>Up Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN1</td>
<td>Link Down</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN2</td>
<td>Link Down</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN3</td>
<td>Link Down</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN4</td>
<td>Link Down</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN5</td>
<td>Link Down</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.4G VM</td>
<td>145M</td>
<td>141083</td>
<td>126812</td>
<td>0</td>
<td>64726</td>
<td>81049</td>
<td>00:16:01</td>
</tr>
<tr>
<td>5G VM</td>
<td>173M</td>
<td>28245</td>
<td>356</td>
<td>0</td>
<td>4127</td>
<td>52</td>
<td>00:16:01</td>
</tr>
</tbody>
</table>

**Poll Interval:** 5 (5-60400 seconds)  

Set Interval  
Stop
The following table describes the traffic statistics fields that display for each of the five LAN ports, for the WLAN1 port in the 2.4 GHz band, and for the WLAN2 port in the 5 GHz band.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The link status and speed of the port.</td>
</tr>
<tr>
<td>TxPkts</td>
<td>The number of packets transmitted on the port since the extender was restarted.</td>
</tr>
<tr>
<td>RxPkts</td>
<td>The number of packets received on the port since the extender was restarted.</td>
</tr>
<tr>
<td>Collisions</td>
<td>The number of collisions on the port since the extender was restarted.</td>
</tr>
<tr>
<td>Tx B/s</td>
<td>The packet transmission rate in bytes per second on the port.</td>
</tr>
<tr>
<td>Rx B/s</td>
<td>The packet reception rate in bytes per second on the port.</td>
</tr>
<tr>
<td>Up Time</td>
<td>The time elapsed since the connection was initiated.</td>
</tr>
</tbody>
</table>

6. To change the poll interval:
   a. Click the Stop button.
   b. In the Poll Interval field, enter a new value in seconds.
   c. Click the Set Interval button.

View the Wired and WiFi Network Devices

You can view the active wired and WiFi devices in both the network to which the extender is connected and the extender network. If you do not recognize a WiFi device, it might be an intruder.

➢ To display the wired and WiFi devices:
   1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
   2. In the address field of your browser, enter www.mywifiext.net.
      You are prompted to enter a user name and password.
   3. Type admin for the user name and type your password.
      If you have not yet personalized your password, type password for the password.
4. Select **Maintenance > Attached Devices.**

![Attached Devices](image)

For each wired and WiFi device, the IP address, device name, MAC address, and virtual MAC address display.

5. (Optional) Click the **Refresh** button.

The information onscreen is updated.
Share a USB Drive That Is Attached to the Extender

This chapter describes how to access and configure a USB storage drive attached to your extender. The USB port on the extender can be used only to connect USB storage devices such as flash drives or hard drives, or a printer. Do not connect computers, USB modems, CD drives, or DVD drives to the extender USB port.

This chapter contains the following sections:

• USB Drive Requirements
• Access a USB Drive on the Network
• Back Up Windows Computers with ReadySHARE Vault
• Back Up Mac Computers with Time Machine
• Control Access to the USB Drive
• Use FTP Within the Network
• View Network Folders on a USB Drive
• Add a Network Folder on a USB Drive
• Change a Network Folder on a USB Drive
• Approve USB Devices
• Safely Remove a USB Drive

Note: For more information about ReadySHARE features, visit www.netgear.com/readyshare.
USB Drive Requirements

The extender works with most USB-compliant external flash and hard drives. For the most up-to-date list of USB drives that the extender supports, visit http://kbserver.netgear.com/readyshare.

Some USB external hard drives and flash drives require you to load the drivers onto the computer before the computer can access the USB device. Such USB devices do not work with the extender.

The extender supports the following file system types for full read and write access:

- FAT16, FAT32
- NTFS
- NTFS with compression format enabled
- Ext2, Ext3, and Ext4
- HFS
- HFS+

**Note:** Do not connect computers, USB modems, CD drives, or DVD drives to the extender USB port.

Access a USB Drive on the Network

ReadySHARE lets you access and share a USB drive connected to the extender USB port. (If your USB drive has special drivers, it is not compatible.)

- **To connect a USB drive:**
  1. Insert your USB storage drive into the USB 3.0 port on the front of the extender.
  2. If your USB drive has a power supply, you must use it when you connect the USB drive to the extender.

     When you connect the USB drive to the extender USB port, it might take up to two minutes before it is ready for sharing. By default, the USB drive is available to all computers on your local area network (LAN).

- **To access the USB drive from a Mac:**
  1. Select Go > Connect to Server.
  2. In the Server Address field, type smb://readyshare as the server address.
  3. Click the Connect button.
  4. When prompted to enter your name and password, select the Guest radio button.
  5. Click the Connect button.
To access the USB drive from a Windows computer:

1. Select Start > Run.
2. Enter \readyshare in the dialog box.
3. Click the OK button.

To map the USB device to a Windows network drive:

2. In the ReadySHARE USB Storage Access pane, click the PC Utility link. The readyshareconnect.exe file is downloaded to your computer.
3. Launch readyshareconnect.exe.

4. Select the drive letter to map to the network folder.
5. If you want to connect to the USB drive as a different user, do the following:
   a. Select the Connect using different credentials check box.
   b. Type the user name and password.
   c. Click the OK button.
6. Click the Finish button.

    The USB drive is mapped to the drive letter that you specified.

Back Up Windows Computers with ReadySHARE Vault

Your extender comes with free backup software for all the Windows computers in your home. Connect a USB hard disk drive (HDD) to the USB port on your extender for centralized, continuous, and automatic backup.
To back up your Windows computer:

1. Connect a USB HDD to a USB port on the extender.
2. Install the genie app on each Windows computer.
   To download the genie app, visit www.netgear.com/genie.
4. Launch ReadySHARE Vault.
5. Use the dashboard or the Backup tab to set up and run your backup.

Back Up Mac Computers with Time Machine

You can use Time Machine to back up your Mac computers onto a USB hard drive that is connected to the extender’s USB port. You can access the connected USB hard drive from your Mac with a wired or WiFi connection to your extender.

Set Up a USB Hard Drive on a Mac

NETGEAR recommends that you use a new USB HDD or format your old USB disk to do the Time Machine backup for the first time. Use a blank partition to prevent some issues during backup using Time Machine. The extender supports GUID or MBR partitions.

To format your USB hard disk drive and specify partitions:

1. Physically connect the USB hard drive to your Mac.
2. On your Mac, go to Spotlight (or the magnifying glass) at the top right of the screen and search for Disk Utility.
3. To format your USB drive, open the Disk Utility, click the Erase tab, and click the Erase button.
4. Click the Partition tab.
5. Click Partition Layout menu and specify the number of partitions that you want to use.
6. Click the Options button.
   The Partition options display.
7. Select the GUID Partition Table or Master Boot Record radio button.
8. For the format, select Mac OS Extended (Journaled).
9. Click the OK button.
10. Click the Apply button.
Prepare to Back Up a Large Amount of Data

Before you back up a large amount of data with Time Machine, NETGEAR recommends that you follow this procedure.

➢ To prepare to back up a large amount of data:
  1. Upgrade the operating system of the Mac computer.
  2. Verify and repair the backup disk and the local disk.
  3. Verify and repair the permissions on the local disk.
  4. Specify Energy Saver:
     a. From the Apple menu, select System Preferences.
     b. From the View menu, select Energy Saver.
     c. Select the Power Adapter tab.
     d. Select the Wake for Wi-Fi network access check box.
     e. Click the back arrow to save the changes and exit the screen.
  5. Modify your Security settings:
     a. From the Apple menu, select System Preferences.
     b. From the View menu, select Security and click the Advanced button at the bottom of the screen.
     c. Leave the Log out after minutes of inactivity check box cleared.

Use Time Machine to Back Up onto a USB Hard Drive

You can use Time Machine to back up your Mac computers onto a USB hard disk drive that is connected to the extender’s USB port.

➢ To back up your Mac onto a USB hard drive:
  1. Prepare your USB drive with a compatible format and partitions (see Set Up a USB Hard Drive on a Mac on page 90).
  2. If you plan to back up a large amount of data, see Prepare to Back Up a Large Amount of Data on page 91.
  3. Insert your USB storage drive into a USB port on the extender.

  Note: If your USB drive has a power supply, you must use it when you connect the USB drive to the extender.

When you connect the USB drive to the extender USB port, it might take up to two minutes before it is ready for sharing. By default, the USB drive is available to all computers on your local area network (LAN).

  4. On your Mac computer, select Go > Connect to Server
  5. In the Server Address field, type smb://readyshare as the server address.
  6. Click the Connect button.
7. When prompted to enter your name and password, select the **Guest** radio button.
8. Click the **Connect** button.

A list of connected devices displays. This list includes the name admin if you log in as admin.

9. From the **Apple** menu, select **System Preferences**.
10. Open Time Machine.
11. Click the **Select Disk** button and select your USB drive from the list.
12. Click the **Use for Backup** button.

**Note:** If you do not see the USB partition that you want in the Time Machine disk list, go to Finder and click that USB partition. Then it displays in the Time Machine list.

13. When prompted to enter your name and password, select the **Guest** radio button.
14. Click the **Connect** button.

When the setup is complete, the Mac automatically schedules a full backup. You can back up immediately if you want.

### Control Access to the USB Drive

You can specify the device name, workgroups, and network folders for your USB device. From your own network, you can access the USB drive over HTTP and, if you enable it, over FTP. You cannot access the USB drive over HTTP or FTP from outside your network.

➢ **To specify the USB access settings:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter **www.mywifiext.net**.

You are prompted to enter a user name and password.

3. Type **admin** for the user name and type your password.

   If you have not yet personalized your password, type **password** for the password.
4. Select **USB Storage > Advanced Settings**.

![USB Storage (Advanced Settings)](image)

5. Specify access to the USB storage device as described in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Device Name</td>
<td>The name that is used to access the USB device. The default name is readyshare.</td>
</tr>
<tr>
<td>Workgroup</td>
<td>The workgroup name, if you are using a Windows workgroup rather than a domain. The name works only in an operating system that supports NetBIOS, such as Microsoft Windows.</td>
</tr>
</tbody>
</table>
| Access Method, Link, and Port | Select the check boxes for the access methods that you want to allow:  
  - **Network Neighborhood/MacShare**. This access method is enabled by default.  
  - **HTTP**. This access method is enabled by default over port 80. The link to access the USB device over HTTP on your network (but not from outside your network) is `http://<IP-address>/readyshare`, in which `<IP-address>` is the IP address that has been assigned to the extender. You can type this link in the address bar of a browser window.  
  - **FTP**. This access method is disabled by default. If you enable this access method, the port for FTP communication is number 21. The link to access the USB device over FTP on your network (but not from outside your network) is `ftp://<IP-address>/readyshare`, in which `<IP-address>` is the IP address that has been assigned to the extender. You can type this link in the address bar of a browser screen. |

6. If you changed the settings, click the **Apply** button.

Your changes are saved.
Use FTP Within the Network

File Transfer Protocol (FTP) lets you send and receive large files faster. By default, FTP is disabled on the extender.

➢ To set up FTP access:
   1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
   2. In the address field of your browser, enter www.mywifihost.net.
      You are prompted to enter a user name and password.
   3. Type admin for the user name and type your password.
      If you have not yet personalized your password, type password for the password.
   4. Select USB Storage > Advanced Settings.

   ![USB Storage Advanced Settings](image)

   5. Select the FTP check box.
      By default, the FTP check box is cleared.
   6. Click the Apply button.
      Your changes are saved.
View Network Folders on a USB Drive

You can view the network folders on the USB storage device. If you have not yet used the extender to create any network folders, only the default network folder is displayed.

➢ To view network folders:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and type your password. If you have not yet personalized your password, type password for the password.
4. Select USB Storage > Advanced Settings.

The Available Networks Folders table shows the network folders on the USB device. The following table describes the columns of the Available Networks Folders table onscreen.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Name</td>
<td>The default share name is USB_Storage. If Not Shared is displayed, the default share has been deleted, and no other share for the root folder exists.</td>
</tr>
<tr>
<td>Read Access</td>
<td>The read and write permissions and access controls on the network folder.</td>
</tr>
<tr>
<td>Write Access</td>
<td>All – no password (which is the default setting) allows all users access to the network folder. The password for admin is the same one that you use to log in to the extender.</td>
</tr>
<tr>
<td>Folder Name</td>
<td>The full path of the network folder.</td>
</tr>
<tr>
<td>Volume Name</td>
<td>The volume name from the storage device.</td>
</tr>
</tbody>
</table>
Add a Network Folder on a USB Drive

You can add network folders on the USB storage device.

To add a network folder:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and type your password. If you have not yet personalized your password, type password for the password.
4. Select USB Storage > Advanced Settings.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Space</td>
<td>The total space of the storage device.</td>
</tr>
<tr>
<td>Free Space</td>
<td>The available space of the storage device.</td>
</tr>
</tbody>
</table>
5. Click the **Create Network Folder** button.

![Create Network Folder](image)

**Note:** If the Create Network Folder screen does not display, your web browser might be blocking pop-ups. If it is, change the browser settings to allow pop-ups.

6. Specify the network folder as described in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Device</td>
<td>From the <strong>USB Device</strong> menu, select the USB drive.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you connect a USB hub to the USB port of the extender, the <strong>USB Device</strong> menu can show more than one USB device.</td>
</tr>
<tr>
<td>Folder</td>
<td>Select a folder:</td>
</tr>
<tr>
<td></td>
<td>1. Click the <strong>Browse</strong> button.</td>
</tr>
<tr>
<td></td>
<td>2. Navigate to the folder that you want to select.</td>
</tr>
<tr>
<td></td>
<td>3. Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td></td>
<td>The folder displays in the <strong>Folder</strong> field.</td>
</tr>
<tr>
<td>Share Name</td>
<td>Type the name of the share.</td>
</tr>
<tr>
<td>Read Access</td>
<td>Select one of the following read access settings:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All – no password</strong>. To read files from the USB device, you do not need to enter a password. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>admin</strong>. To read files from the USB device, you must enter the password that you use to log in to the extender.</td>
</tr>
<tr>
<td>Write Access</td>
<td>Select one of the following write access settings:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All – no password</strong>. To write files to the USB device, you do not need to enter a password. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>admin</strong>. To write files to the USB device, you must enter the password that you use to log in to the extender.</td>
</tr>
</tbody>
</table>

7. Click the **Apply** button.

The folder is added on the USB device.
Change a Network Folder on a USB Drive

You can change a network folder on the USB storage device.

➢ To change a network folder:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net.
   You are prompted to enter a user name and password.
3. Type admin for the user name and type your password.
   If you have not yet personalized your password, type password for the password.
4. Select USB Storage > Advanced Settings.

   ![USB Storage Configuration](image)

   1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
   2. In the address field of your browser, enter www.mywifiext.net.
   3. Type admin for the user name and type your password.
   4. Select USB Storage > Advanced Settings.
   5. Select the folder that you want to edit by selecting its associated radio button.

5. Select the folder that you want to edit by selecting its associated radio button.
6. Click the Edit button.

![Edit Network Folder](image)

**Note:** If the Edit Network Folder screen does not display, your web browser might be blocking pop-ups. If it is, change the browser settings to allow pop-ups.

7. Change the network folder as described in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| USB Device    | From the USB Device menu, select the USB drive.  
*Note:* If you connect a USB hub to the USB port of the extender, the USB Device menu can show more than one USB device. |
| File System   | The file system that the extender has detected. You cannot change this information. |
| Folder        | Select a folder:  
1. Click the Browse button.  
2. Navigate to the folder that you want to select.  
3. Click the OK button.  
The folder displays in the Folder field. |
| Share Name    | Type the name of the share. |
| Read Access   | Select one of the following read access settings:  
*All – no password.* To read files from the USB device, you do not need to enter a password. This is the default setting.  
*admin.* To read files from the USB device, you must enter the password that you use to log in to the extender. |
| Write Access  | Select one of the following write access settings:  
*All – no password.* To write files to the USB device, you do not need to enter a password. This is the default setting.  
*admin.* To write files to the USB device, you must enter the password that you use to log in to the extender. |
8. Click the **Apply** button.
Your changes are saved.

### Approve USB Devices

For more security, you can set up the extender to share only USB devices that you approve.

- To approve USB devices:
  1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
  2. In the address field of your browser, enter **www.mywifiext.net**.
      You are prompted to enter a user name and password.
  3. Type **admin** for the user name and type your password.
      If you have not yet personalized your password, type **password** for the password.
  4. Select **Advanced > USB Settings**.
     - By default the **Yes** radio button is selected. This setting lets you connect and access all your USB drives.
  5. Click the **Approved Devices** button.
The approved and available USB devices display. The previous figure shows one approved device and one available device that is not yet approved.

6. In the Available USB Devices table, select the drive that you want to approve.

   **Note:** If you connect a USB hub to the USB port of the extender, the Available USB Devices table can show more than one USB device.

7. Click the **Add** button.
8. Select the **Allow only approved devices** check box.
9. Click the **Apply** button.

   The USB device is added to the Approved USB Devices table. Your change takes effect.

10. To approve another USB device:
    a. Select **USB Storage > Basic Settings**.
    b. Click the **Safely Remove USB Device** button for the currently connected USB device.
    c. Connect the other USB device.
    d. Click the **Refresh** button.
    e. Repeat **Step 4** through **Step 9**.

---

**Safely Remove a USB Drive**

Before you physically disconnect a USB drive from the extender USB port, log in to the extender and take the drive offline.

➢ **To remove a USB disk drive safely:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter **www.mywifient.net**.
   You are prompted to enter a user name and password.
3. Type **admin** for the user name and type your password.
   If you have not yet personalized your password, type **password** for the password.
4. Select **USB Storage > Basic Settings**.
5. Click the **Safely Remove USB Device** button.
   The drive goes offline.
6. Physically disconnect the USB drive.
Use the Extender as a Media Server

This chapter contains the following sections:

• Specify ReadyDLNA Media Server Settings
• Play Media from a USB Drive on TiVo

Note: For information about how to connect the USB drive and to specify its settings, see Chapter 5, Share a USB Drive That Is Attached to the Extender.
Specify ReadyDLNA Media Server Settings

By default, the extender functions as a ReadyDLNA media server, which lets you stream music and movies from an attached USB device to DLNA/UPnP AV-compliant media players, such as Xbox360, Playstation, and NETGEAR media players.

➢ To specify media server settings:

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifiext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and type your password. If you have not yet personalized your password, type password for the password.
4. Select USB Storage > Media Server.

5. Specify the settings as described in the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Media Server</td>
<td>Select this check box to enable the extender to function as a media server. (By default, this check box is already selected.)</td>
</tr>
<tr>
<td>Enable TiVo support</td>
<td>Select this check box to enable the extender to play ReadyNAS media on your TiVo device. (By default, this check box is already selected.) For more information, see the Play Media from a USB Drive on TiVo on page 104.</td>
</tr>
<tr>
<td>Media Server Device Name</td>
<td>Specify the name of the media server. The default name is ReadyDLN.</td>
</tr>
<tr>
<td>Content Scan</td>
<td>Select this check box to enable the extender to automatically scan and detect media files that are added to the attached USB device. (By default, this check box is already selected.) Note: The extender scans only shared folders that have full read access without a password.</td>
</tr>
</tbody>
</table>

6. Click the Apply button. Your changes are saved.
Play Media from a USB Drive on TiVo

You can set up your TiVo to access media files stored on a USB device that is connected to your extender. The TiVo must be on the same network as the extender. This feature supports the following file formats:

- **Video.** See and play mpeg1, and mpeg2 files.
- **Music.** See and play MP3 files.
- **Pictures.** View images in jpg format.

You can use the TiVo (Series 2 and up) Home Media Option to play photos and music on your Windows or Mac computer in your TiVo user interface.

➢ **To set up the extender to work with TiVo:**

1. On your computer, launch an Internet browser such as Mozilla Firefox or Microsoft Internet Explorer.
2. In the address field of your browser, enter www.mywifext.net. You are prompted to enter a user name and password.
3. Type admin for the user name and type your password. If you have not yet personalized your password, type password for the password.
4. Select USB Storage > Media Server.
5. If it is not yet selected, select the Enable TiVo support check box.
6. Click the Apply button.
    
    Your changes are saved.
To play videos:
1. On the TiVo, select TiVo Central > My Shows.

2. Go to the bottom of the list and select the EX6200.
   (The following figure shows not the EX6200 but the R7000.)

To play music or view photos:
1. On the TiVo, select TiVo Central > Music, Photos, & Showcases.
2. Select an item to play or watch.
   (The following figure shows not the EX6200 but the R7000.)

➢ To copy TiVo files to a computer:
Share a USB Printer Through the Extender

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port on your extender. You can share this USB printer among the Windows and Mac computers on your network.

This chapter contains the following sections:

• Install the Printer Driver and Cable the Printer
• Download the ReadySHARE Printer Utility
• Install the ReadySHARE Printer Utility
• Use the Shared Printer
• View or Change the Status of a Printer
• Use the Scan Feature of a Multifunction USB Printer
• Change NETGEAR USB Control Center Settings

**Note:** For more information about ReadySHARE features, visit [www.netgear.com/readyshare](http://www.netgear.com/readyshare).

**Note:** For information about how to connect the USB drive and to specify its settings, see Chapter 5, *Share a USB Drive That Is Attached to the Extender.*
Install the Printer Driver and Cable the Printer

Some USB printer manufacturers (for example, HP and Lexmark printers) request that you do not connect the USB cable until the installation software prompts you to do so.

➢ To install the driver and cable the printer:
  1. On each computer on your network that shares the USB printer, install the driver software for the USB printer.
     If you do not have the printer driver, contact the printer manufacturer.
  2. Use a USB printer cable to connect the USB printer to the extender USB port.

Download the ReadySHARE Printer Utility

The utility works on Windows and Mac computers.

➢ To download the utility:
  2. In the ReadySHARE Printer pane, click the PC Utility or Mac Utility link.
  3. Follow the onscreen instructions to download the file.

Install the ReadySHARE Printer Utility

You must install the ReadySHARE Printer utility on each computer on which you want to share the USB printer. After you install it, the utility displays as NETGEAR USB Control Center on your computer.
To install the utility on a computer:

1. Double-click the ReadySHARE Printer utility setup file that you downloaded. The InstallShield wizard displays.

2. Follow the wizard instructions to install NETGEAR USB Control Center. After the InstallShield Wizard completes the installation, the NETGEAR USB Control Center prompts you to select a language.

3. Select a language from the list and click the **OK** button.
The NETGEAR USB Control Center displays the main screen.

![NETGEAR USB Control Center](image)

**Note:** Some firewall software, such as Comodo, blocks NETGEAR USB Control Center from accessing the USB printer. If you do not see the USB printer displayed in the screen, you can disable the firewall temporarily to allow the utility to work.

4. Select the printer and click the **Connect** button.
   The printer status changes to Manually connected by *Mycomputer*. Now, only your computer can use the printer.

5. Click the **Disconnect** button.
   The status changes to Available. Now all computers on the network can use the printer.

**Note:** After you click the **Connect** and **Disconnect** buttons once, the utility automatically manages the printing queue and handling.

6. To exit the utility, select **System > Exit**.

**Use the Shared Printer**

After you have installed the ReadySHARE Printer utility, by default, when you log on to Windows, the utility starts automatically and runs in the background.

➢ **To manually connect and print from the printer that is connected to the extender:**

1. On your computer, click the **NETGEAR USB Control Center** icon.
   The main screen displays.

2. Click the **Connect** button.
   The printer status changes to Manually connected by *Mycomputer*. Now, only the computer you are using can use this printer.

3. Use the print feature in your application to print your document.
4. To release the printer connection so that all computers on the network can use it, click the **Disconnect** button.

➢ **To print and release the connection to the printer that is connected to the extender:**

1. To print your document from your computer, use the print feature in your application. The NETGEAR USB Control Center automatically connects your computer to the USB printer and prints the document. If another computer is already connected to the printer, your print job goes into a queue to wait to be printed.

2. If your document does not print, use the NETGEAR USB Control Center to check the status.

### View or Change the Status of a Printer

The NETGEAR USB Control Center displays the status of the USB printer that is connected to the extender. You can view the status or change the status manually.

➢ **To view or change the status:**

1. On your computer, click the **NETGEAR USB Control Center** icon.

   The main screen displays.

   ![NETGEAR USB Control Center](image)

   The Status column shows the status for each device:

   - **Available.** No print jobs are in process. You can use the USB printer from any computer in the network.
   - **Connected.** Your computer is connected to the printer. When your print job is done, the printer connection is released.
   - **Manually Connected by.** Only the connected computer can use the printer.
   - **Waiting to Connect.** Your computer is not connected to the shared printer yet.

2. To change the status from Manually Connected by another computer to Available, click the **Disconnect** button.

   The printer connection is released and the status changes to Available.

3. To change the status from Waiting to Connect to Available, click the **Connect** button.

   The printer status changes to Manually connected by my computer. Now, only your computer can use the printer.

4. To allow the printer to be shared, click the **Disconnect** button.

   The printer connection is released and the status changes to Available.
Use the Scan Feature of a Multifunction USB Printer

If the USB printer that is connected to the extender supports scanning, you can also use the USB printer for scanning. For example, the USB printer displayed in the Windows Printers and Faxes screen is ready for print jobs.

To use the scan feature of a multifunction USB printer:

1. Launch the NETGEAR USB Control Center.
2. Make sure that the printer status shows as Available.
3. Click the **Network Scanner** button.

The scanner screen displays so that you can use the USB printer for scanning.
Change NETGEAR USB Control Center Settings

You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows. You can also change the language and specify the time-out to release the connection to the USB printer that is connected to the extender.

➢ To turn off automatic NETGEAR USB Control Center startup:

1. Launch the NETGEAR USB Control Center.
2. Select Tools > Configuration.
3. Clear the Automatically execute when logging on Windows check box.
4. Click the OK button.

Your changes are saved.

➢ To change the language:

1. Launch the NETGEAR USB Control Center.
2. Select Tools > Configuration.
3. In the Language list, select a language.
4. Click the OK button.

The next time NETGEAR USB Control Center starts, the language changes.

➢ To specify the time-out:

1. Launch the NETGEAR USB Control Center.
2. Select Tools > Configuration.
3. In the Timeout field, type the number of minutes.

The time-out period is the number of minutes that a computer holds its connection to the USB printer when the connection is not being used.
4. Click the OK button.

Your changes are saved.
FAQs and Troubleshooting

This chapter covers the following topics:

- FAQs
- You Cannot Connect to the Extender
- You Cannot Join a WiFi Network and Receive an Error Message
- Improve the Connection Between the Extender and the WiFi Router
FAQs

This section provides answers for difficulties you might experience with the extender.

1. **Question.** Does the extender work if I connect it to my WiFi router with an Ethernet cable?
   
   **Answer.** No, the extender is designed only to connect over WiFi to a WiFi router.

2. **Question.** What are the default user name and password to log in to the extender?
   
   **Answer.** If you are online at www.mywifiext.net, you can use the following user name and password to log in:
   
   • **User name.** admin
   
   • **Password.** password

3. **Question.** When I try to connect to the network, Smart Setup keeps asking me for my passphrase, and I am sure I've entered the correct passphrase. What can I do?
   
   **Answer.** It is likely that the extender is placed at the borderline of the range that the WiFi router covers. For more information, see *How to Position the Extender* on page 16 and *Improve the Connection Between the Extender and the WiFi Router* on page 121.

4. **Question.** I receive an error message on the Review Settings screen on Smart Setup. What can I do?
   
   **Answer.** Make sure that your computer or mobile device is connected to the extender by using the SSID and the passphrase that you have set up and clicking the **Refresh** button in your browser. You should be returned to Smart Setup.

5. **Question.** I connected to NETGEAR_EXT and launched a browser, but why can I not see Smart Setup?
   
   **Answer.** First, make sure that your device is set up to use DHCP. Second, make sure that the Device to Extender Connection LED is green. Finally, relaunch the browser and enter www.mywifiext.net.

6. **Question.** I enabled a wireless MAC filter, wireless access control, or access control list (ACL) on my router. What should I do when installing the extender?
   
   **Answer.** When the WiFi device connects through the extender to your router, the MAC address of the wireless device shown on the router is translated to another MAC address. If your router’s MAC filter, wireless access control, or ACL is enabled, the WiFi device connects to the extender but cannot get an IP address from the extender and cannot access the Internet. To allow the wireless device to receive an IP address from the extender and access the Internet, you must provide the translated MAC address to the router.

   To add a translated MAC address to your router:

   1. Log in to your router and disable the MAC filter, wireless access control, or ACL.

      For more information on how to disable your router’s MAC filter, wireless access control, or ACL, see your router’s documentation.
2. Power on the extender and connect all of your WiFi devices to the extender.
3. Make sure that the Link Rate LED remains lit.
4. Log in to your extender.
   a. Launch a web browser and in the address field, enter www.mywifext.net or www.mywifext.com.
      A login screen displays.
   b. Enter admin for the user name and password for the password.
5. Select Maintenance > Attached Devices.
   The Attached Devices screen displays the MAC addresses and virtual MAC addresses for computers and WiFi devices that are connected to the extender network.
6. On the router, add all of the virtual MAC addresses from your extender to your router’s MAC filter table.
7. Pull out the product label from the extender and find the extender’s MAC 1 and MAC 2 addresses.
8. Add the extender’s MAC 1 address to your router’s MAC filter table.
9. Add the extender’s MAC 2 address to your router’s MAC filter table.
   You must type 02:0F:B5: first, then type the last six digits of your MAC 2 address after.
   For example, if your MAC 2 address is C4:04:15:5F:20:AC, type 02:0F:B5:5F:20:AC in your router’s MAC filter table.
10. Convert the extender’s MAC 1 Address and add the new MAC 1 address to your router’s MAC filter table.
   a. Convert the first two hexadecimal values in the extender’s MAC 1 address to binary.
      For example, if the first two hexadecimal values in your MAC 1 address is C4, the binary code for C is 1100 and the binary code for 4 is 0100. Therefore, the binary code for C4 is 1100/0100 (see Table 2, Hexadecimal value to binary numbers).

Table 2. Hexadecimal value to binary numbers

<table>
<thead>
<tr>
<th>Hexadecimal values</th>
<th>Binary numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0000</td>
</tr>
<tr>
<td>1</td>
<td>0001</td>
</tr>
<tr>
<td>2</td>
<td>0010</td>
</tr>
<tr>
<td>3</td>
<td>0011</td>
</tr>
<tr>
<td>4</td>
<td>0100</td>
</tr>
<tr>
<td>5</td>
<td>0101</td>
</tr>
</tbody>
</table>
b. Toggle the second to last digit of the binary code to one or zero.

If the second to last digit is one, toggle it to zero. If the second to last digit is zero, toggle it to one. For example, if the binary code is 1100/0100, the new binary code is 1100/0110.

c. Convert the new binary code back to a hexadecimal value.

For example, if the binary code is 1100/0110, the new hexadecimal value is C6 (see Table 3, Binary Numbers to hexadecimal values).

<table>
<thead>
<tr>
<th>Table 2. Hexadecimal value to binary numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal values</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>F</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 3. Binary Numbers to hexadecimal values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary numbers</td>
</tr>
<tr>
<td>0000</td>
</tr>
<tr>
<td>0001</td>
</tr>
<tr>
<td>0010</td>
</tr>
<tr>
<td>0011</td>
</tr>
<tr>
<td>0100</td>
</tr>
<tr>
<td>0101</td>
</tr>
<tr>
<td>0110</td>
</tr>
<tr>
<td>0111</td>
</tr>
<tr>
<td>1000</td>
</tr>
<tr>
<td>1001</td>
</tr>
<tr>
<td>1010</td>
</tr>
</tbody>
</table>
d. Replace the first two hexadecimal values in the old MAC 1 address with the new value you converted and add the new MAC 1 address to your router’s MAC filter table.

For example, if your old MAC 1 address was C4:04:15:5F:20:AD, your new MAC 1 address is C6:04:15:5F:20:AD.

11. Enable the router’s MAC filter, wireless access control, or ACL.

7. **Question.** My router security is WEP, and I entered the wrong passphrase or security key on the extender. I cannot access the extender anymore. What can I do?

**Answer.** The extender cannot detect whether the WEP passphrase is correct. If you entered the wrong passphrase, your WiFi device cannot get the IP address from the extender. You must reset the extender to the factory defaults to get the IP address back.

8. **Question.** Is seamless roaming supported? During a VoIP call, when I move to a different location, the call is dropped. What should I do?

**Answer.** No, the extender does not support seamless roaming. You might notice performance issues if your WiFi device (laptop, smartphone, or tablet) connects to a different WiFi network. For example, you might connect to the extender WiFi network, begin a call, and then move to the location of your existing WiFi network. Your WiFi device automatically connects to the network in your current location, which takes a few seconds and might cause your call to be dropped. To prevent this situation, decide which WiFi network you want to use for your VoIP call, and stay within the range of that network.

### Table 3. Binary Numbers to hexadecimal values

<table>
<thead>
<tr>
<th>Binary numbers</th>
<th>Hexadecimal values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1011</td>
<td>B</td>
</tr>
<tr>
<td>1100</td>
<td>C</td>
</tr>
<tr>
<td>1101</td>
<td>D</td>
</tr>
<tr>
<td>1110</td>
<td>E</td>
</tr>
<tr>
<td>1111</td>
<td>F</td>
</tr>
</tbody>
</table>

**You Cannot Connect to the Extender**

If you have trouble connecting to the extender, determine what prevents you from connecting:

- Make sure that you use the correct user name and password to log in:
  - **User name.** admin
  - **Password.** password
- If your browser displays an error page, include `http://` in the address field of your browser by typing `http://www.mywifiext.net`. 
AC1200 WiFi Range Extender

- If you already set up the extender but can no longer connect to it over WiFi, check if the Link Rate LED is off or red. For more information, see *Improve the Connection Between the Extender and the WiFi Router* on page 121.
- If you cannot get a WiFi connection working, you can use an Ethernet cable to connect your computer to the extender. For more information, see *Access the Extender over Ethernet and Use Smart Setup* on page 27.
You Cannot Join a WiFi Network and Receive an Error Message

To join a WiFi network, you must know its network name (also called the SSID) so that you can select it. If the network is secure, you must know the passphrase or key. If the extender does not connect to the network that you select, the cause might be one of the following:

- You might have typed the network name, passphrase, or key incorrectly. Use Smart Setup (see Run Smart Setup Again After Initial Setup on page 69) to select a WiFi network from the list with detected networks, and retype the passphrase or key. The passphrase or key is case-sensitive. For example, PASSWORD25 is not the same as Password25 or password25.

- If the extender cannot detect your WiFi network, check to see if your WiFi network is still up. Make sure that the WiFi router is turned on. If possible, move the extender closer to the WiFi router. For more information, see Improve the Connection Between the Extender and the WiFi Router on page 121.

- If the extender Link Rate LED is red, a poor WiFi connection exists between the WiFi router and the extender. You can establish the best connection with a clear line of sight between the extender and the WiFi router. Make sure that no physical obstacles exist between the extender and the WiFi router, and try to move the extender closer to the WiFi router. For more information, see Improve the Connection Between the Extender and the WiFi Router on page 121.

If you use Smart Setup, and the extender cannot connect to the WiFi router or cannot get an IP address from the WiFi router, or the WiFi router is not connected to the Internet, Smart Setup might display the following message:

You are not able to connect to Internet. Click “Continue” to run through setup or “Exit” to manually configure the connection.

Either run Smart Setup again, exit Smart Setup and configure the connection manually (see Connect the Extender to a WiFi Network Without Using Smart Setup on page 39), or try Smart Setup again later (see Run Smart Setup Again After Initial Setup on page 69).
Improve the Connection Between the Extender and the WiFi Router

The extender LEDs can help you tell whether the extender is correctly set up and working as it should.

- **To improve the connection between the extender and the WiFi router:**
  1. Move the extender closer to the WiFi router or to a different spot where it provides a better line of sight.
     
     You might need to unplug the extender, plug it in again at its new location, and restart it. Unless the extender is outside the range of your WiFi router, the extender connects automatically to the WiFi router.
  2. As you move the extender, continue to check the Link Rate LED and the Device to Extender LED on the top panel until you find a location where the Link Rate LED is green or amber, and the Device to Extender LED is green.

The following tables describe how the LEDs show the quality of the connection.

### 2.4 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Both the Link Rate LED and the Device to Extender LED are green." /></td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is amber and the Device to Extender LED is green." /></td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is red." /></td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is off." /></td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>

### 5 GHz LED Status

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Both the Link Rate LED and the Device to Extender LED are green." /></td>
<td>The extender provides the best performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is amber and the Device to Extender LED is green." /></td>
<td>The extender provides a workable performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is red." /></td>
<td>The extender provides a poor performance.</td>
</tr>
<tr>
<td><img src="image" alt="The Link Rate LED is off." /></td>
<td>The extender cannot function.</td>
</tr>
</tbody>
</table>
Factory Settings and Technical Specifications

This appendix covers the following topics:

- Factory Default Settings
- Technical and Environmental Specifications
## Factory Default Settings

To reset the extender to factory default settings, you can use either the **Restore Factory Settings** button on the rear panel or the Erase function. For more information, see *Return the Extender to Its Factory Default Settings* on page 78.

The following table shows the factory default settings.

**Table 4. Factory default settings**

<table>
<thead>
<tr>
<th>Factory Settings</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Setup</td>
<td>Enabled</td>
</tr>
<tr>
<td><strong>WiFi</strong></td>
<td></td>
</tr>
<tr>
<td>WiFi communication</td>
<td>Enabled</td>
</tr>
<tr>
<td>WiFi network name (SSID)</td>
<td>NETGEAR_EXT</td>
</tr>
<tr>
<td>Security</td>
<td>Disabled</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>Auto&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>Country/region</td>
<td>Varies by region</td>
</tr>
<tr>
<td>Operating mode</td>
<td>802.11ac, 802.11n, 802.11g, 802.11b</td>
</tr>
<tr>
<td>Data rate in the 2.4 GHz band</td>
<td>Up to 150 Mbps</td>
</tr>
<tr>
<td>Data rate in the 5 GHz band</td>
<td>Up to 867 Mbps</td>
</tr>
<tr>
<td>DHCP</td>
<td>Client enabled</td>
</tr>
</tbody>
</table>

<sup>1</sup> Maximum WiFi signal rate (IEEE Standard 802.11). Actual throughput can vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead lower actual data throughput rate.
The following table shows the technical and environmental specifications.

**Table 5. Technical specifications**

<table>
<thead>
<tr>
<th>Technical Specifications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network protocol and standards compatibility</td>
<td>Data and routing protocols: TCP/IP, DHCP server and client, DNS relay, NAT (many-to-one), VPN pass-through (IPSec, PPTP)</td>
</tr>
<tr>
<td>Power adapter</td>
<td>• North America (input): 120V, 60 Hz</td>
</tr>
<tr>
<td></td>
<td>• All regions (output): 12 VDC @ 2.5A 30W maximum</td>
</tr>
<tr>
<td>Physical specifications</td>
<td>• Dimensions: 9.72 x 6.85 x 1.22 in (247 x 174 x 31 mm)</td>
</tr>
<tr>
<td></td>
<td>• Weight: 0.67 lb (302 g)</td>
</tr>
<tr>
<td>Environmental</td>
<td>• Operating temperature: 32° to 140°F (0° to 40°C)</td>
</tr>
<tr>
<td></td>
<td>• Operating humidity: 90% maximum relative humidity, noncondensing</td>
</tr>
<tr>
<td>Interface</td>
<td>• Local: 10BASE-T, 100BASE-TX, 1000BASE-TX, RJ-45</td>
</tr>
<tr>
<td></td>
<td>• USB 3.0</td>
</tr>
<tr>
<td></td>
<td>• 802.11ac, 802.11n, 802.11a, 802.11g, 802.11b</td>
</tr>
<tr>
<td>Electromagnetic emissions</td>
<td>Meets requirements of FCC Part 15 Class B.</td>
</tr>
</tbody>
</table>